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e² studio 2026-04.3 (2026-04.3.R20260611-0916) 
Release Note  
Introduction 
This document outlines the device support, new features added in 2026-04.3, fixed issues and open issues in e² studio 
2026-04.3. 
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1. Product Information 
1.1 Supported Operating Systems 

These operating systems are officially supported by e² studio: 

• Windows 10 64-bit 

• Windows 11 64-bit 

 

In addition, another official product build is available for Linux. This version supports: 

• Ubuntu 22.04 LTS 

• Ubuntu 24.04 LTS 

Note: No other Linux distributions are officially supported by e² studio. 

 

In addition, another official product build is available for Mac OS. This version supports: 

• Mac OS 15 (Sequoia) 

• Mac OS 26 (Tahoe) 

 

Supported Device Family: 
 
Device Family Windows Product 

Support 
Linux Product Support Mac OS Product 

Support 
EC-1 Yes No No 

RA Yes Yes Yes 

RH850 Yes Yes No 

RL78 Yes Yes Yes 

RX Yes Yes Yes 

RZ Yes 
(No RZ/G Linux Platform 

Tools) 

Yes No 

Synergy Yes No No 

DA Yes Yes Yes 

RISC-V MCU Yes Yes No 
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1.2 System requirements 

For Windows 64-bit version 

• System: x64 based processor, 2 GHz or faster, CPU has dual cores or more 
o Windows® 11 (64-bit version) 

• Memory capacity: We recommend 8 GB or more. At least 4 GB. 
• Capacity of hard disk: At least 2 GB of free space. 
• Display: Graphics resolution should be at least 1024 x 768, and the mode should display at least 65,536 colors. 
• Interface: USB 2.0 
• Microsoft Visual C++ 2010 SP1 runtime library *1 
• Microsoft Visual C++ 2015-2019 runtime library *1 

*1. This software will be installed at the same time as the e² studio. 

For Linux 

• System: x64 based processor, 2 GHz or faster, CPU has dual cores or more 
o Ubuntu 22.04 LTS Desktop (64-bit version) 
o Ubuntu 24.04 LTS Desktop (64-bit version) 

• Memory capacity: We recommend 2 GB or more. 
• Capacity of hard disk: At least 2 GB of free space. 

For Mac OS 

• System: 1.8 GHz or faster 64-bit processor. Dual-core or better recommended. Apple Silicon (arm64) 
processors are only supported. 

o Mac OS 15 (Sequoia) 
o Mac OS 26 (Tahoe) 

• Memory capacity: 4 GB of RAM; 8 GB of RAM recommended. 
• Capacity of hard disk: At least 2 GB of free space. 
• A screen resolution of 1280 x 800 or higher. 

e² studio now runs on Java 21 & does not support older Java versions. 

  



e² studio 2026-04.3 Release Documentation Release Note 

R20UT5849EG0100     Rev.1.00  Page 5 of 59 
22nd June 2026  

1.2.1 Windows version 
The Windows product supports RA, DA RX, RL78, RH850, RZ, RISC-V and Synergy. 

Device Family Toolchain Emulator 

RA GCC, LLVM E2 Emulator, E2 Emulator Lite, Segger J-link 

DA GCC, LLVM Segger J-link 

RX CC-RX, GCC E2 Emulator, E2 Emulator Lite, Segger J-link 

RL78 CC-RL, GCC, LLVM E2 Emulator, E2 Emulator Lite, COM port debugging 

RH850 CC-RH E2 Emulator 

RZ GCC Segger J-link 

RISC-V LLVM E2 Emulator, E2 Emulator Lite, Segger J-link 

Synergy GCC E2 Emulator, E2 Emulator Lite, Segger J-link 

EC-1 GCC Segger J-link 

 

For information on how to install the Windows product please refer to FAQ in the below URL. 

English: https://ja-support.renesas.com/knowledgeBase/21018828 
Japanese: https://en-support.renesas.com/knowledgeBase/21018832 

 

1.2.2 Linux version 
The Linux product version of e² studio is based on the same content as the Windows release. 

Therefore, documents of e² studio will be helpful for common usages. There are some differences, the Linux version 
only supports some different levels of tooling. 

The Linux product supports RA, DA RX, RL78, RH850, RZ and RISC-V. 

Device Family Toolchain Emulator 

RA GCC, LLVM E2 Emulator, E2 Emulator Lite, Segger J-link 

DA GCC, LLVM Segger J-link 

RX CC-RX, GCC E2 Emulator, E2 Emulator Lite, Segger J-link 

RL78 CC-RL, GCC, LLVM E2 Emulator, E2 Emulator Lite, COM port debugging 

RH850 CC-RH E2 Emulator 

RZ GCC Segger J-link 

RISC-V LLVM Segger J-link 

Synergy Unsupported Unsupported 

 

For information on how to install the Linux product please refer to the following documents. 

English: https://en-support.renesas.com/knowledgeBase/19934358 
https://www.renesas.com/document/mat/quick-start-guide-linux-hosted-version-e-studio?language=en 

Japanese: https://ja-support.renesas.com/knowledgeBase/19934356 
https://www.renesas.com/document/mat/quick-start-guide-linux-hosted-version-e-studio?language=ja 

  

https://ja-support.renesas.com/knowledgeBase/21018828
https://en-support.renesas.com/knowledgeBase/21018832
https://en-support.renesas.com/knowledgeBase/19934358
https://www.renesas.com/document/mat/quick-start-guide-linux-hosted-version-e-studio?language=en
https://ja-support.renesas.com/knowledgeBase/19934356
https://www.renesas.com/document/mat/quick-start-guide-linux-hosted-version-e-studio?language=ja


e² studio 2026-04.3 Release Documentation Release Note 

R20UT5849EG0100     Rev.1.00  Page 6 of 59 
22nd June 2026  

1.2.3 Mac OS version 
The Mac OS product version of e² studio is based on the same content as the Windows release. 

The MacOS product version only supports the ARM architecture of Apple devices (Apple Silicon). 

 Therefore, documents of e² studio will be helpful for common usages. There are some differences, the Mac OS version 
only supports some different levels of tooling. 

The Mac OS product supports RA, DA RX and RL78. 

Device Family Toolchain Emulator 

RA GCC, LLVM E2 Emulator, E2 Emulator Lite, Segger J-link 

DA GCC, LLVM Segger J-link 

RX GCC E2 Emulator, E2 Emulator Lite, Segger J-link 

RL78 CC-RL, GCC, LLVM E2 Emulator, E2 Emulator Lite, COM port debugging 

RH850 Unsupported Unsupported 

RZ Unsupported Unsupported 

RISC-V Unsupported Unsupported 

Synergy Unsupported Unsupported 

 
For information on how to install the Mac OS product please refer to the document below. 

English: https://www.renesas.com/document/qsg/quick-start-guide-e-studio-macos?language=en 
Japanese: https://www.renesas.com/document/qsg/quick-start-guide-e-studio-macos?language=ja 

 
FSP setup steps 
 
You may also like to install the FSP packs for RA in the e² studio. 
 
If developing for RA MCUs, it is now necessary to download and install FSP. 
Open a browser on: 

• https://github.com/renesas/fsp 
and download the ZIP file containing the packs for the current release – this must be FSP 4.6.0 or later to contain 
appropriate support for debugging on macOS. 
Next steps mean these packs need to be installed to the e² studio internal support files directory. 
 
This can be manually forced by running the e² studio application and opening the project generator and working through 
the project generator wizard pages. The project generator can be accessed via the New->Renesas C/C++ project menu 
entry for the device you are using. 
  

https://www.renesas.com/document/qsg/quick-start-guide-e-studio-macos?language=en
https://www.renesas.com/document/qsg/quick-start-guide-e-studio-macos?language=ja
https://github.com/renesas/fsp
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The support files directory is generated for the local machine you are running on. To get this location we can retrieve 
this from the “About E2studio” dialog. Please see the steps below: 
 
Open the About E2studio dialog: 

 
And click on “Installation Details”: 
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Then select the “Support Folders” tab, and then click on the “e² studio support area:” link to open a Filer window. You 
should see an “internal folder” here: 

 
At this point, close the e² studio application. 
Now copy the “internal” folder from the temporary directory that you previously extracted the contents of to the 
“internal” folder in the e² studio support files folder: 

 
[Note that you can copy rather than moving in Filer by drag and dropping with Option key pressed.] 
When prompted, select the Merge option: 

 
Pack installation should then be completed, and you can restart the e² studio application. 
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1.3 Supported Toolchains – Windows Hosted 
The following toolchains are supported in e² studio. 

 
   Renesas GNU Arm  

Embedded 
(*2) 

Renesas GCC/  
GNURZ/ARM 
(*3) 

IAR (*4) Green 
Hills (*5) 

LLVM (*6) 

D
ev

ic
e 

Fa
m

ily
 

RL78 Yes (CC-
RL) 

No Yes Yes No Yes 

RX Yes (CC-
RX) 

No Yes Yes No No 

RH850 Yes (CC-
RH) 

No No Yes Yes No 

RZ/ARM  No No (*1) Yes Yes No No 

EC-1/ARM No No Yes No No No 

Synergy/ARM No Yes No Yes No No 

RA/ARM No Yes No Yes No Yes 

DA/ARM No Yes No No No No 

RISC-V MCU No No No No No Yes 
 
Note:  
*1: Project converter is available to convert from GNUARM RZ/none to GNU ARM Embedded toolchain. 

*2: The GCC toolchains for RZ Family and Renesas Synergy™ are distributed via  
Arm Developer at https://developer.arm.com/downloads/-/arm-gnu-toolchain-downloads (GCC 11.2 and 
later),  https://developer.arm.com/downloads/-/gnu-rm (GCC 5.3 to 10.3)  
or Launchpad.net at: https://launchpad.net/gcc-arm-embedded (GCC 5.2 and older). They are also 
available using the “Additional components” page in the e² studio installer. Supported ARM GCC versions 
vary from device family to device family. Please see the following table for more information: 

*3: Legacy GNUARM toolchains are available from https://llvm-gcc-renesas.com/. In addition, the latest  
RX and RL78 Renesas GCC toolchains are available from this website. 
Also LLVM for RL78 is available from https://llvm-gcc-renesas.com/ . 

*4: The IAR toolchain plugins are available via the “Help”->” IAR Embedded Workbench plugin manager” 
menu in e² studio. These Eclipse plugins are provided by IAR and are not supported by Renesas.  

*5: The Green Hills toolchain plugins are available within the e² studio product. These plugins are provided 
by Green Hills and are not supported by Renesas. 

*6: The LLVM for Arm toolchain is available from https://github.com/ARM-software/LLVM-embedded-
toolchain-for-Arm/releases .The RISC-V LLVM toolchain is available from https://llvm-gcc-
renesas.com/riscv/riscv-download-toolchains/ . 

  

https://developer.arm.com/downloads/-/arm-gnu-toolchain-downloads
https://developer.arm.com/downloads/-/gnu-rm
https://launchpad.net/gcc-arm-embedded
https://llvm-gcc-renesas.com/
https://llvm-gcc-renesas.com/
https://github.com/ARM-software/LLVM-embedded-toolchain-for-Arm/releases
https://github.com/ARM-software/LLVM-embedded-toolchain-for-Arm/releases
https://llvm-gcc-renesas.com/riscv/riscv-download-toolchains/
https://llvm-gcc-renesas.com/riscv/riscv-download-toolchains/
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 Device Family GCC distribution and version 

RZ/A1, A2 12.2.Rel1 

RZ/A3UL,A3M FSP 1.0.0: AArch64 bare-metal 10.3.2021.07 
FSP 1.1.0: AArch64 bare-metal 10.3.2021.07 
FSP 1.2.0: AArch64 bare-metal 10.3.2021.07 
FSP 1.2.1: AArch64 bare-metal 10.3.2021.07 
FSP 2.0.0: AArch64 bare-metal 10.3.2021.07 
FSP 2.0.1: AArch64 bare-metal 10.3.2021.07 
FSP 2.0.2: AArch64 bare-metal 13.2.Rel1 
FSP 3.0.0: AArch64 bare-metal 13.2.Rel1 
FSP 3.1.0: AArch64 bare-metal 13.2.Rel1 
FSP 3.2.0: AArch64 bare-metal 13.2.Rel1 
FSP 3.3.0: AArch64 bare-metal 13.2.Rel1 
FSP 3.4.0: AArch64 bare-metal 13.2.Rel1 
FSP 3.5.0: AArch64 bare-metal 13.2.Rel1 
FSP 3.6.0: AArch64 bare-metal 13.2.Rel1 
FSP 4.0.0: AArch64 bare-metal 13.2.Rel1 
FSP 4.1.0: AArch64 bare-metal 13.2.Rel1 

RZ/G1, G2 (Cortex-A) Linaro 7.4.1 

RZ/G2L, G2LC, G2UL, G3E, 
G3S (Cortex-M33) 

FSP 1.0.0: 9.2.1(2019q4) 
FSP 1.1.0: 9.2.1(2019q4) 
FSP 1.2.0: 9.2.1(2019q4) 
FSP 1.2.0: 9.2.1(2019q4) 
FSP 2.0.0: 10.3-2021.10 
FSP 2.0.1: 10.3-2021.10 
FSP 2.1.0: 10.3-2021.10 
FSP 3.0.0: 13.3.Rel1 
FSP 3.1.0: 13.3.Rel1 
FSP 4.0.0: 13.3.Rel1 
FSP 4.1.0: 13.3.Rel1 

RZ/N2L, N2H FSP 1.0.0: 9.3.1(2020q2) 
FSP 1.1.0: 9.3.1(2020q2) 
FSP 1.2.0: 9.3.1(2020q2) 
FSP 1.3.0: 12.2.Rel1 
FSP 2.0.0: 12.2.Rel1 
FSP 2.1.0: CR52: 12.2.Rel1, CA55: 10.3.2021.07 
FSP 2.2.0: CR52: 12.2.Rel1, CA55: 10.3.2021.07 
FSP 3.0.0: CR52: 13.2.Rel1, CA55: 10.3.2021.07 
FSP 3.1.0: CR52: 13.2.Rel1, CA55: 10.3.2021.07 
FSP 4.0.0: CR52: 13.3.Rel1, CA55: 13.2.Rel1 
FSP 4.1.0: CR52: 13.3.Rel1, CA55: 13.2.Rel1 

RZ/T2M, T2ME, T2L, T2H FSP 1.0.0: 9.3.1(2020q2) 
FSP 1.1.0: 9.3.1(2020q2) 
FSP 1.2.0: 9.3.1(2020q2) 
FSP 1.3.0: 12.2.Rel1 
FSP 2.0.0: 12.2.Rel1 
FSP 2.1.0: 12.2.Rel1 
FSP 2.2.0: CR52: 12.2.Rel1, CA55: 10.3-2021.07 
FSP 2.3.0: CR52: 13.3.Rel1, CA55: 10.3-2021.07 
FSP 3.0.0: CR52: 13.3.Rel1, CA55: 10.3-2021.07 
FSP 3.1.0: CR52: 13.3.Rel1, CA55: 10.3-2021.07 
FSP 4.0.0: CR52: 13.3.Rel1, CA55: 13.2.Rel1 
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FSP 4.1.0: CR52: 13.3.Rel1, CA55: 13.2.Rel1 

RZ/V2L, V2H, V2N FSP 1.0.0: 9.2.1(2019q4) 
FSP 1.1.0: 9.2.1(2019q4) 
FSP 2.0.0: 12.2.Rel1 
FSP 2.0.1: 12.2.Rel1 
FSP 2.0.2: 12.2.Rel1 
FSP 3.0.0: 13.3.Rel1 
FSP 3.1.0: 13.3 Rel1 
FSP 4.0.0: CR52: 13.3.Rel1, CA55: 13.2.Rel1 
FSP 4.1.0: CR52: 13.3.Rel1, CA55: 13.2.Rel1 

Synergy SSP 1.6.x: 7.2.1 
SSP 1.7.x: 7.2.1 
SSP 2.0, 2.1, 2.2 <-> 2.2: 9.2.1 and 7.2.1 
SSP 2.3, 2.4, 2.5, 2.6, 2.7: 10.3-2021.10 

RA FSP 3.5.0: 10.3-2021.10 
FSP 3.6.0: 10.3-2021.10 
FSP 3.7.0: 10.3-2021.10 
FSP 3.8.0: 10.3-2021.10 
FSP 3.9.0: 10.3-2021.10 
FSP 4.0.0: 10.3-2021.10 
FSP 4.1.0: 10.3-2021.10 
FSP 4.2.0: 10.3-2021.10 
FSP 4.3.0: 10.3-2021.10 
FSP 4.4.0: 10.3-2021.10 
FSP 4.5.0: 10.3-2021.10 
FSP 4.6.0: 10.3-2021.10 
FSP 5.0.0: GCC: 12.2.Rel1, LLVM: 17.0.1 
FSP 5.0.1: GCC: 12.2.Rel1, LLVM: 17.0.1 
FSP 5.1.0: GCC: 13.2.Rel1, LLVM: 17.0.1 
FSP 5.2.0: GCC: 13.2.Rel1, LLVM: 17.0.1 
FSP 5.3.0: GCC: 13.2.Rel1, LLVM: 17.0.1 
FSP 5.4.0: GCC: 13.2.Rel1, LLVM: 18.1.3 
FSP 5.5.0: GCC: 13.2.Rel1, LLVM: 18.1.3 
FSP 5.6.0: GCC: 13.2.Rel1, LLVM: 18.1.3 
FSP 5.7.0: GCC: 13.2.Rel1, LLVM: 18.1.3 
FSP 5.8.0: GCC: 13.2.Rel1, LLVM: 18.1.3 
FSP 5.9.0: GCC: 13.2.Rel1, LLVM: 18.1.3 
FSP 6.0.0: GCC: 13.2.Rel1, LLVM: 18.1.3 
FSP 6.1.0: GCC: 13.2.Rel1, LLVM: 18.1.3 
FSP 6.2.0: GCC: 13.2.Rel1, LLVM: 18.1.3 
FSP 6.3.0: GCC: 13.2.Rel1, LLVM: 21.1.1, 
FSP 6.4.0: GCC: 13.2.Rel1, LLVM: 21.1.1, 
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1.4 Supported Toolchains – Linux Hosted 
The following toolchains are supported in e² studio: 

• Linaro GCC – tested version 7.3.1-201805 

• GNU ARM Embedded 13.3-Rel1 

• GNU ARM Embedded 10.3 2021.10 

• GCC ARM A-Profile (AArch64 bare-metal) 13.3.Rel1 

• CC for Renesas 4.9.2.202103-GNURL78 

• GCC for Renesas 14.2.0.202511-GNURX 

• GCC for Renesas 8.3.0.202411-GNURX 

• LLVM Embedded Toolchain for Arm 18.1.3 

• LLVM Embedded Toolchain for Arm 17.0.1 

• LLVM for Renesas RL78 17.0.1.202512 

• LLVM for Renesas RL78 10.0.0.202312 

• LLVM for Renesas RISC-V 17.0.2.202407 

• LLVM for Renesas RISC-V MCU 19.1.7.202501 

• CC-RX V3.07.00 

• CC-RL V1.16.00 

• CC-RH V2.07.00 

 

1.5 Supported Toolchains – Mac OS Hosted 
The following toolchains are supported in e² studio: 

• CC-RL V1.16.01 

• ARM GNU Toolchains for Mac OS 

https://developer.arm.com/downloads/-/arm-gnu-toolchain-downloads 

• GCC for Renesas 8.3.0.202411-GNURX MacOS (ARM, experimental) 

• GCC for Renesas 14.2.0.202511-GNURX MacOS (ARM, experimental) 

• LLVM for Renesas RL78 10.0.0.202312 MacOS (ARM) 

• LLVM for Renesas RL78 17.0.1.202512 MacOS (ARM) 

 

  

https://developer.arm.com/downloads/-/arm-gnu-toolchain-downloads
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2. Device Support 
2.1 Project Generator Support 
Note1: The Renesas SH device family is no longer supported in e² studio. 

Note2: SDK import feature is available for DA, instead of new project generation. 

Family Group   Devices 

DA 

DA1453x DA14531(DA14531-00), DA14531-01, DA14533, DA14535 
DA1458x DA14585, DA14586 
DA1459x DA14592, DA14594 
DA1469x DA14691, DA14695, DA14697, DA14699 
DA1470x DA14701, DA14705, DA14706, DA14708 
DA148xx DA14850, DA14870 
DA16200 DA16200 
DA16600 DA16600 

EC-1 EC-1 R9A06G043 

RA 

RA0 R7FA0E105, R7FA0E107, R7FA0E207, R7FA0E209, R7FA0L105, 
R7FA0L107 

RA2 

R7FA2A1AB, R7FA2A2AD, R7FA2A2BD, R7FA2E1A5, R7FA2E1A7, 
R7FA2E1A8, R7FA2E1A9, R7FA2E2A3, R7FA2E2A5, R7FA2E2A7, 
R7FA2E305, R7FA2E307, R7FA2L1A9, R7FA2L1AB, R7FA2L207, 
R7FA2L209, R7FA2T107 

RA4 

R7FA4C1BB, R7FA4C1BD, R7FA4E10B, R7FA4E10D, R7FA4E2B9, 
R7FA4L1BB, R7FA4L1BD, R7FA4M1AB, R7FA4M2AB, 
R7FA4M2AC, R7FA4M2AD, R7FA4M3AD, R7FA4M3AE, 
R7FA4M3AF, R7FA4T1B9, R7FA4T1BB, R7FA4W1AD 

RA6 

R7FA6E10D, R7FA6E10F, R7FA6E2B9, R7FA6E2BB, R7FA6M1AD, 
R7FA6M2AD, R7FA6M2AF, R7FA6M3AF, R7FA6M3AH, 
R7FA6M4AD, R7FA6M4AE, R7FA6M4AF, R7FA6M5AG, 
R7FA6M5AH, R7FA6M5BF, R7FA6M5BG, R7FA6M5BH, 
R7FA6T1AB, R7FA6T1AD, R7FA6T2AB, R7FA6T2AD, R7FA6T2BB, 
R7FA6T2BD, R7FA6T3BB, R7SA6W1AE, R7SA6W1BE, 
R7SA6W1CE, R7SA6W2AE, R7SA6W2BE, R7SA6W2CE 

RA8 

R7FA8D1AF, R7FA8D1AH, R7FA8D1BF, R7FA8D1BH, R7FA8E1AF, 
R7FA8E2AF, R7FA8M1AF, R7FA8M1AH, R7FA8T1AF, R7FA8T1AH, 
R7JA8D2JR, R7JA8D2JS, R7JA8D2KR, R7JA8D2KS, R7JA8M2LR, 
R7JA8M2LS, R7JA8P1JR, R7JA8P1JS, R7JA8P1KR, R7JA8P1KS, 
R7JA8T2LR, R7JA8T2LS, R7KA8D2AD, R7KA8D2AF, R7KA8D2BD, 
R7KA8D2BF, R7KA8D2JF, R7KA8D2KF, R7KA8M2AD, 
R7KA8M2AF, R7KA8M2JF, R7KA8P1AD, R7KA8P1AF, 
R7KA8P1BD, R7KA8P1BF, R7KA8P1JF, R7KA8P1KF, R7KA8T2AD, 
R7KA8T2AF, R7KA8T2CD, R7KA8T2CF, R7KA8T2JF, R7KA8T2LF, 
R7JA8D2JR_CPU0, R7JA8D2JR_CPU1, R7JA8D2JS_CPU0, 
R7JA8D2JS_CPU1, R7JA8D2KR_CPU0, R7JA8D2KR_CPU1, 
R7JA8D2KS_CPU0, R7JA8D2KS_CPU1, R7JA8M2LR_CPU0, 
R7JA8M2LR_CPU1, R7JA8M2LS_CPU0, R7JA8M2LS_CPU1, 
R7JA8P1JR_CPU0, R7JA8P1JR_CPU1, R7JA8P1JS_CPU0, 
R7JA8P1JS_CPU1, R7JA8P1KR_CPU0, R7JA8P1KR_CPU1, 
R7JA8P1KS_CPU0, R7JA8P1KS_CPU1, R7JA8T2LR_CPU0, 
R7JA8T2LR_CPU1, R7JA8T2LS_CPU0, R7JA8T2LS_CPU1, 
R7KA8D2JF_CPU0, R7KA8D2JF_CPU1, R7KA8D2KF_CPU0, 
R7KA8D2KF_CPU1, R7KA8M2JF_CPU0, R7KA8M2JF_CPU1, 
R7KA8P1JF_CPU0, R7KA8P1JF_CPU1, R7KA8P1KF_CPU0, 
R7KA8P1KF_CPU1, R7KA8T2JF_CPU0, R7KA8T2JF_CPU1, 
R7KA8T2LF_CPU0, R7KA8T2LF_CPU1 

RH850 C1H R7F701260, R7F701270 
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C1M R7F701263, R7F701271 
C1M-A1 R7F701278 
C1M-A2 R7F701275 

D1L1 R7F701401, R7F701421 
D1L2 R7F701402, R7F701422 
D1M1 R7F701404, R7F701405 

D1M1-V2 R7F701442, R7F701462 
D1M2 R7F701408, R7F701410, R7F701428, R7F701430 
E1L R7F701201, R7F701205 

E1M-S R7F701202, R7F701204 
E1M-S2 R7F701215, R7F701216 

- R7F701Z05, R7F701Z06, R7F701Z07 

F1H 

R7F701501, R7F701502, R7F701503, R7F701506, R7F701507, 
R7F701508, R7F701511, R7F701512, R7F701513, R7F701526, 
R7F701527, R7F701528, R7F701529, R7F701530, R7F701531, 
R7F701534 

 

- R7F701521, R7F701522, R7F701524, R7F701525 

F1K 

R7F701542, R7F701543, R7F701546, R7F701547, R7F701557, 
R7F701560, R7F701561, R7F701562, R7F701563, R7F701566, 
R7F701567, R7F701577, R7F701580, R7F701581, R7F701582, 
R7F701583, R7F701586, R7F701587, R7F701597, R7F701602, 
R7F701603, R7F701610, R7F701611, R7F701612, R7F701613, 
R7F701620, R7F701621, R7F701622, R7F701623 

F1KH R7F701708, R7F701709, R7F701710, R7F701711, R7F701714, 
R7F701715 

F1KM 

R7F701644, R7F701645, R7F701646, R7F701647, R7F701648, 
R7F701649, R7F701650, R7F701651, R7F701652, R7F701653, 
R7F701684, R7F701685, R7F701686, R7F701687, R7F701688, 
R7F701689, R7F701690, R7F701691, R7F701692, R7F701693, 
R7F701694, R7F701695, R7F701760, R7F701762, R7F701764, 
R7F701A55, R7F701A56, R7F701A57, R7F701A58, R7F701A59, 
R7F701A60, R7F701A61, R7F701A62, R7F701A63, R7F701A64, 
R7F701A65, R7F701A66, R7F701A67, R7F701A68, R7F701A69, 
R7F701A70, R7F701A71, R7F701A72, R7F701A73, R7F701A74, 
R7F701A75, R7F701A76, R7F701A77, R7F701A78, R7F701A79, 
R7F701A80, R7F701A81, R7F701A82, R7F701A83, R7F701A84 

F1L 

R7F701002xAFP, R7F701003xAFP, R7F701006xAFP, 
R7F701007xAFP, R7F701008xAFP, R7F701009xAFP, 
R7F701010xAFP, R7F701011xAFP, R7F701012xAFP, 
R7F701013xAFP, R7F701014xAFP, R7F701015xAFP, 
R7F701016xAFP, R7F701017xAFP, R7F701018xAFP, 
R7F701019xAFP, R7F701020xAFP, R7F701021xAFP, 
R7F701022xAFP, R7F701023xAFP, R7F701024xAFP, 
R7F701025xAFP, R7F701026xAFP, R7F701027xAFP, 
R7F701028xAFP, R7F701029xAFP, R7F701030xAFP, 
R7F701032xAFP, R7F701033xAFP, R7F701034xAFP, R7F701040, 
R7F701041, R7F701042, R7F701043, R7F701044, R7F701045, 
R7F701046, R7F701047, R7F701048, R7F701049, R7F701050, 
R7F701051, R7F701052, R7F701053, R7F701054, R7F701055, 
R7F701056, R7F701057 

F1M 
R7F701544, R7F701545, R7F701548, R7F701549, R7F701552, 
R7F701553, R7F701564, R7F701565, R7F701568, R7F701569, 
R7F701572, R7F701573 

P1H-C R7F701370AEEBG, R7F701371EABG, R7F701372EABG, 
R7F701396EABG 

P1L-C R7F701388, R7F701389, R7F701390, R7F701391 
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P1M 
R7F701304, R7F701305, R7F701310, R7F701311, R7F701312, 
R7F701313, R7F701314, R7F701315, R7F701318, R7F701319, 
R7F701320, R7F701321, R7F701322, R7F701323 

P1M-C R7F701373xABG, R7F701374xAFP, R7F701397xABG 

P1M-E 
R7F701375, R7F701376, R7F701377, R7F701378, R7F701379, 
R7F701380, R7F701381, R7F701382, R7F701383, R7F701384, 
R7F701385, R7F701386 

- 
R7F701060xAFP, R7F701062xAFP, R7F701064xAFP, 
R7F701065xAFP, R7F701067xAFP, R7F701069xAFP, 
R7F701071xAFP 

 

U2A-EVA R7F702Z19A, R7F702Z19B 
U2A16 R7F702300, R7F702300A, R7F702300B 
U2A6 R7F702302 
U2A8 R7F702301, R7F702301A, R7F702301B 

U2B10 R7F70254x_Fusa, R7F70254x_Performance, R7F702Z21, 
R7F702Z26 

U2B24 R7F702Z23, R7F702Z28 
U2B6 R7F70255x, R7F702Z22 

U2B6-E R7F7025Dx 
U2B12-E R7F7025Cx_Fusa, R7F7025Cx_Performance 
U2B16-E R7F7025Fx_Fusa, R7F7025Fx_Performance 

U2B24-E R7F70259x_Fusa, R7F70259x_Performance, R7F7025Bx_Fusa, 
R7F7025Bx_Performance 

U2C2 R7F702615A 
U2C4 R7F702606A 
U2C8 R7F702600A 

U2C8-EVA R7F702Z32A 
RISC-V MCU G021 R9A02G021 
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RL78 

D1A 

R5F10CGB, R5F10CGC, R5F10CGD, R5F10CLD, R5F10CMD, 
R5F10CME, R5F10DGC, R5F10DGD, R5F10DGE, R5F10DLD, 
R5F10DLE, R5F10DMD, R5F10DME, R5F10DMF, R5F10DMG, 
R5F10DMJ, R5F10DPE, R5F10DPF, R5F10DPG, R5F10DPJ, 
R5F10DPK, R5F10DPL, R5F10DSJ, R5F10DSK, R5F10DSL, 
R5F10TPJ 

F12 

R5F10968, R5F1096A, R5F1096B, R5F1096C, R5F1096D, 
R5F1096E, R5F109AA, R5F109AB, R5F109AC, R5F109AD, 
R5F109AE, R5F109BA, R5F109BB, R5F109BC, R5F109BD, 
R5F109BE, R5F109GA, R5F109GB, R5F109GC, R5F109GD, 
R5F109GE, R5F109LA, R5F109LB, R5F109LC, R5F109LD, 
R5F109LE 

F13 

R5F10A6A, R5F10A6C, R5F10A6D, R5F10A6E, R5F10AAA, 
R5F10AAC, R5F10AAD, R5F10AAE, R5F10ABA, R5F10ABC, 
R5F10ABD, R5F10ABE, R5F10AGA, R5F10AGC, R5F10AGD, 
R5F10AGE, R5F10AGF, R5F10AGG, R5F10ALC, R5F10ALD, 
R5F10ALE, R5F10ALF, R5F10ALG, R5F10AME, R5F10AMF, 
R5F10AMG, R5F10BAC, R5F10BAD, R5F10BAE, R5F10BAF, 
R5F10BAG, R5F10BBC, R5F10BBD, R5F10BBE, R5F10BBF, 
R5F10BBG, R5F10BGC, R5F10BGD, R5F10BGE, R5F10BGF, 
R5F10BGG, R5F10BLC, R5F10BLD, R5F10BLE, R5F10BLF, 
R5F10BLG, R5F10BME, R5F10BMF, R5F10BMG 

F14 

R5F10PAD, R5F10PAE, R5F10PBD, R5F10PBE, R5F10PGD, 
R5F10PGE, R5F10PGF, R5F10PGG, R5F10PGH, R5F10PGJ, 
R5F10PLE, R5F10PLF, R5F10PLG, R5F10PLH, R5F10PLJ, 
R5F10PME, R5F10PMF, R5F10PMG, R5F10PMH, R5F10PMJ, 
R5F10PPE, R5F10PPF, R5F10PPG, R5F10PPH, R5F10PPJ 

F15 

R5F113GK, R5F113GL, R5F113LK, R5F113LL, R5F113MK, 
R5F113ML, R5F113PG, R5F113PH, R5F113PJ, R5F113PK, 
R5F113PL, R5F113TG, R5F113TH, R5F113TJ, R5F113TK, 
R5F113TL 

F1A R5F114GC, R5F114GD, R5F114GE, R5F114GF, R5F114GG 

F1E R5F11KLE, R5F11KLF, R5F11KLG, R5F11LLE, R5F11LLF, 
R5F11LLG 

F22 R7F122F7G, R7F122FBG, R7F122FGG 
F23 R7F123FBG, R7F123FGG, R7F123FLG, R7F123FMG 
F24 R7F124FBJ, R7F124FGJ, R7F124FLJ, R7F124FMJ, R7F124FPJ 

- R7F125FGL, R7F125FLL, R7F125FML, R7F125FPL 
FGIC RAJ240055, RAJ240057, RAJ240090, RAJ240100, RAJ240310 

G10 R5F10Y14, R5F10Y16, R5F10Y17, R5F10Y44, R5F10Y46, 
R5F10Y47 

G11 R5F1051A, R5F1054A, R5F1056A, R5F1057A, R5F1058A 

G12 

R5F10266, R5F10267, R5F10268, R5F10269, R5F1026A, 
R5F10277, R5F10278, R5F10279, R5F1027A, R5F102A7, 
R5F102A8, R5F102A9, R5F102AA, R5F10366, R5F10367, 
R5F10368, R5F10369, R5F1036A, R5F10377, R5F10378, 
R5F10379, R5F1037A, R5F103A7, R5F103A8, R5F103A9, 
R5F103AA 

G13 

R5F1006A, R5F1006C, R5F1006D, R5F1006E, R5F1007A, 
R5F1007C, R5F1007D, R5F1007E, R5F1008A, R5F1008C, 
R5F1008D, R5F1008E, R5F100AA, R5F100AC, R5F100AD, 
R5F100AE, R5F100AF, R5F100AG, R5F100BA, R5F100BC, 
R5F100BD, R5F100BE, R5F100BF, R5F100BG, R5F100CA, 
R5F100CC, R5F100CD, R5F100CE, R5F100CF, R5F100CG, 
R5F100EA, R5F100EC, R5F100ED, R5F100EE, R5F100EF, 
R5F100EG, R5F100EH, R5F100FA, R5F100FC, R5F100FD, 
R5F100FE, R5F100FF, R5F100FG, R5F100FH, R5F100FJ, 
R5F100FK, R5F100FL, R5F100GA, R5F100GC, R5F100GD, 
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R5F100GE, R5F100GF, R5F100GG, R5F100GH, R5F100GJ, 
R5F100GK, R5F100GL, R5F100JC, R5F100JD, R5F100JE, 
R5F100JF, R5F100JG, R5F100JH, R5F100JJ, R5F100JK, 
R5F100JL, R5F100LC, R5F100LD, R5F100LE, R5F100LF, 
R5F100LG, R5F100LH, R5F100LJ, R5F100LK, R5F100LL, 
R5F100MF, R5F100MG, R5F100MH, R5F100MJ, R5F100MK, 
R5F100ML, R5F100PF, R5F100PG, R5F100PH, R5F100PJ, 
R5F100PK, R5F100PL, R5F100SH, R5F100SJ, R5F100SK, 
R5F100SL, R5F1016A, R5F1016C, R5F1016D, R5F1016E, 
R5F1017A, R5F1017C, R5F1017D, R5F1017E, R5F1018A, 
R5F1018C, R5F1018D, R5F1018E, R5F101AA, R5F101AC, 
R5F101AD, R5F101AE, R5F101AF, R5F101AG, R5F101BA, 
R5F101BC, R5F101BD, R5F101BE, R5F101BF, R5F101BG, 
R5F101CA, R5F101CC, R5F101CD, R5F101CE, R5F101CF, 
R5F101CG, R5F101EA, R5F101EC, R5F101ED, R5F101EE, 
R5F101EF, R5F101EG, R5F101EH, R5F101FA, R5F101FC, 
R5F101FD, R5F101FE, R5F101FF, R5F101FG, R5F101FH, 
R5F101FJ, R5F101FK, R5F101FL, R5F101GA, R5F101GC, 
R5F101GD, R5F101GE, R5F101GF, R5F101GG, R5F101GH, 
R5F101GJ, R5F101GK, R5F101GL, R5F101JC, R5F101JD, 
R5F101JE, R5F101JF, R5F101JG, R5F101JH, R5F101JJ, 
R5F101JK, R5F101JL, R5F101LC, R5F101LD, R5F101LE, 
R5F101LF, R5F101LG, R5F101LH, R5F101LJ, R5F101LK, 
R5F101LL, R5F101MF, R5F101MG, R5F101MH, R5F101MJ, 
R5F101MK, R5F101ML, R5F101PF, R5F101PG, R5F101PH, 
R5F101PJ, R5F101PK, R5F101PL, R5F101SH, R5F101SJ, 
R5F101SK, R5F101SL 

G13A R5F140FK, R5F140FL, R5F140GK, R5F140GL, R5F140LK, 
R5F140LL, R5F140PK, R5F140PL 

G14 

R5F104AA, R5F104AC, R5F104AD, R5F104AE, R5F104AF, 
R5F104AG, R5F104BA, R5F104BC, R5F104BD, R5F104BE, 
R5F104BF, R5F104BG, R5F104CA, R5F104CC, R5F104CD, 
R5F104CE, R5F104CF, R5F104CG, R5F104EA, R5F104EC, 
R5F104ED, R5F104EE, R5F104EF, R5F104EG, R5F104EH, 
R5F104FA, R5F104FC, R5F104FD, R5F104FE, R5F104FF, 
R5F104FG, R5F104FH, R5F104FJ, R5F104GA, R5F104GC, 
R5F104GD, R5F104GE, R5F104GF, R5F104GG, R5F104GH, 
R5F104GJ, R5F104GK, R5F104GL, R5F104JC, R5F104JD, 
R5F104JE, R5F104JF, R5F104JG, R5F104JH, R5F104JJ, 
R5F104LC, R5F104LD, R5F104LE, R5F104LF, R5F104LG, 
R5F104LH, R5F104LJ, R5F104LK, R5F104LL, R5F104MF, 
R5F104MG, R5F104MH, R5F104MJ, R5F104MK, R5F104ML, 
R5F104PF, R5F104PG, R5F104PH, R5F104PJ, R5F104PK, 
R5F104PL 

G15 R5F12007, R5F12008, R5F12017, R5F12018, R5F12047, R5F12048, 
R5F12067, R5F12068 

G16 R5F1211A, R5F1211C, R5F1214A, R5F1214C, R5F1216A, 
R5F1216C, R5F1217A, R5F1217C, R5F121BA, R5F121BC 

G1A 
R5F10E8A, R5F10E8C, R5F10E8D, R5F10E8E, R5F10EBA, 
R5F10EBC, R5F10EBD, R5F10EBE, R5F10EGA, R5F10EGC, 
R5F10EGD, R5F10EGE, R5F10ELC, R5F10ELD, R5F10ELE 

G1C R5F10JBC, R5F10JGC, R5F10KBC, R5F10KGC 
G1D R5F11AGG, R5F11AGH, R5F11AGJ 

G1E R5F10FLC, R5F10FLD, R5F10FLE, R5F10FMC, R5F10FMD, 
R5F10FME 

G1F R5F11B7C, R5F11B7E, R5F11BBC, R5F11BBE, R5F11BCC, 
R5F11BCE, R5F11BGC, R5F11BGE, R5F11BLC, R5F11BLE 

G1G R5F11EA8, R5F11EAA, R5F11EB8, R5F11EBA, R5F11EF8, 
R5F11EFA 
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G1H R5F11FLJ, R5F11FLK, R5F11FLL 
G1K R5F11VBG, R5F11VLG 
G1M R5F11W67, R5F11W68 
G1N R5F11Y67, R5F11Y68 
G1P R5F11Z7A, R5F11ZBA 

G22 

R7F102G4C, R7F102G4E, R7F102G6C, R7F102G6E, R7F102G7C, 
R7F102G7E, R7F102G8C, R7F102G8E, R7F102GAC, R7F102GAE, 
R7F102GBC, R7F102GBE, R7F102GCC, R7F102GCE, R7F102GEC, 
R7F102GEE, R7F102GFC, R7F102GFE, R7F102GGC, R7F102GGE 

G23 

R7F100GAF, R7F100GAG, R7F100GAH, R7F100GAJ, R7F100GBF, 
R7F100GBG, R7F100GBH, R7F100GBJ, R7F100GCF, R7F100GCG, 
R7F100GCH, R7F100GCJ, R7F100GEF, R7F100GEG, R7F100GEH, 
R7F100GEJ, R7F100GFF, R7F100GFG, R7F100GFH, R7F100GFJ, 
R7F100GFK, R7F100GFL, R7F100GFN, R7F100GGF, R7F100GGG, 
R7F100GGH, R7F100GGJ, R7F100GGK, R7F100GGL, 
R7F100GGN, R7F100GJF, R7F100GJG, R7F100GJH, R7F100GJJ, 
R7F100GJK, R7F100GJL, R7F100GJN, R7F100GLF, R7F100GLG, 
R7F100GLH, R7F100GLJ, R7F100GLK, R7F100GLL, R7F100GLN, 
R7F100GMG, R7F100GMH, R7F100GMJ, R7F100GMK, 
R7F100GML, R7F100GMN, R7F100GPG, R7F100GPH, R7F100GPJ, 
R7F100GPK, R7F100GPL, R7F100GPN, R7F100GSJ, R7F100GSK, 
R7F100GSL, R7F100GSN 

G24 
R7F101G6E, R7F101G6G, R7F101G7E, R7F101G7G, R7F101G8E, 
R7F101G8G, R7F101GAE, R7F101GAG, R7F101GBE, R7F101GBG, 
R7F101GEE, R7F101GEG, R7F101GFE, R7F101GFG, R7F101GGE, 
R7F101GGG, R7F101GJE, R7F101GJG, R7F101GLE, R7F101GLG 

H1D R5F11NGF, R5F11NGG, R5F11NLF, R5F11NLG, R5F11NME, 
R5F11NMF, R5F11NMG, R5F11PLF, R5F11PLG, R5F11RMG 

I1A R5F1076C, R5F107AC, R5F107AE, R5F107DE 
I1B R5F10MME, R5F10MMG, R5F10MPE, R5F10MPG 

I1C 
R5F10NLE, R5F10NLG, R5F10NME, R5F10NMG, R5F10NMJ, 
R5F10NML, R5F10NML_DUAL, R5F10NPG, R5F10NPJ, R5F10NPL, 
R5F10NPL_DUAL 

I1C-2 R5F11TLE, R5F11TLG 

I1D 
R5F11768, R5F1176A, R5F11778, R5F1177A, R5F117A8, 
R5F117AA, R5F117AC, R5F117BA, R5F117BC, R5F117GA, 
R5F117GC 

I1E R5F11CBC, R5F11CCC 

L12 
R5F10RB8, R5F10RBA, R5F10RBC, R5F10RF8, R5F10RFA, 
R5F10RFC, R5F10RG8, R5F10RGA, R5F10RGC, R5F10RJ8, 
R5F10RJA, R5F10RJC, R5F10RLA, R5F10RLC 

L13 
R5F10WLA, R5F10WLC, R5F10WLD, R5F10WLE, R5F10WLF, 
R5F10WLG, R5F10WMA, R5F10WMC, R5F10WMD, R5F10WME, 
R5F10WMF, R5F10WMG 

L1A R5F11MMD, R5F11MME, R5F11MMF, R5F11MPE, R5F11MPF, 
R5F11MPG 

L1C 

R5F110ME, R5F110MF, R5F110MG, R5F110MH, R5F110MJ, 
R5F110NE, R5F110NF, R5F110NG, R5F110NH, R5F110NJ, 
R5F110PE, R5F110PF, R5F110PG, R5F110PH, R5F110PJ, 
R5F111ME, R5F111MF, R5F111MG, R5F111MH, R5F111MJ, 
R5F111NE, R5F111NF, R5F111NG, R5F111NH, R5F111NJ, 
R5F111PE, R5F111PF, R5F111PG, R5F111PH, R5F111PJ 

 L23 

R7F100LFE, R7F100LFG, R7F100LFJ, R7F100LFL, R7F100LGE, 
R7F100LGG, R7F100LGJ, R7F100LGL, R7F100LJE, R7F100LJG, 
R7F100LJJ, R7F100LJL, R7F100LLE, R7F100LLG, R7F100LLJ, 
R7F100LLL, R7F100LMG, R7F100LMJ, R7F100LML, R7F100LPG, 
R7F100LPJ, R7F100LPL 
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RX 

110 R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110J 

111 R5F51111, R5F51113, R5F51114, R5F51115, R5F51116, R5F51117, 
R5F51118, R5F5111J 

113 R5F51135, R5F51136, R5F51137, R5F51138 

130 R5F51303, R5F51305, R5F51305B, R5F51306, R5F51306B, 
R5F51307, R5F51308 

13T R5F513T3, R5F513T5 
140 R5F51403, R5F51405, R5F51406 
14T R5F514T5 

210 R5F52103, R5F52104, R5F52105, R5F52106, R5F52107, R5F52108, 
R5F5210A, R5F5210B 

21A R5F521A6, R5F521A7, R5F521A8 
220 R5F52201, R5F52203, R5F52205, R5F52206 
230 R5F52305, R5F52306 
231 R5F52315, R5F52316, R5F52317, R5F52318 

23E-A R5F523E5A, R5F523E5S, R5F523E6A, R5F523E6S 
23E-B R5F523E5B, R5F523E6B 
23T R5F523T3, R5F523T5 
23W R5F523W7, R5F523W8 
24T R5F524T8, R5F524TA, R5F524TB, R5F524TC, R5F524TE 
24U R5F524UB, R5F524UC, R5F524UE 
260 R5F52606, R5F52607, R5F52608 
261 R5F52616, R5F52617, R5F52618 

26T R5F526T8, R5F526T9, R5F526TA, R5F526TB, R5F526TF, 
R5F526TF_DUAL 

610 R5F56104, R5F56106, R5F56107, R5F56108 
621 R5F56216, R5F56217, R5F56218 
62G R5F562G7, R5F562GA 
62N R5F562N7, R5F562N8 
62T R5F562T6, R5F562T7, R5F562TA 

630 R5F56307, R5F56308, R5F5630A, R5F5630B, R5F5630D, 
R5F5630E 

631 

R5F56316, R5F56317, R5F56318, R5F5631A, R5F5631B, 
R5F5631D, R5F5631E, R5F5631F, R5F5631G, R5F5631J, 
R5F5631K, R5F5631M, R5F5631MF, R5F5631N, R5F5631P, 
R5F5631PF, R5F5631W, R5F5631Y, R5S56310 

634 R5F5634B, R5F5634B_5V, R5F5634D, R5F5634D_5V, R5F5634E, 
R5F5634E_5V 

63N R5F563NA, R5F563NB, R5F563ND, R5F563NE, R5F563NF, 
R5F563NK, R5F563NW, R5F563NY 

63T R5F563T4, R5F563T5, R5F563T6, R5F563TB, R5F563TB_5V, 
R5F563TC, R5F563TC_5V, R5F563TE, R5F563TE_5V 

64M R5F564MF, R5F564MG, R5F564MJ, R5F564ML 

651 

R5F56514, R5F56517, R5F56519, R5F5651C, R5F5651C_DUAL, 
R5F5651E, R5F5651E_DUAL 
 
R5F56519DMB, R5F5651EDMB, R5F5651EDMB_DUAL,(Debug 
Support Only) 

65N 

R5F565N4, R5F565N7, R5F565N9, R5F565NC, R5F565NC_DUAL, 
R5F565NE, R5F565NE_DUAL 
 
R5F565N9DMB, R5F565NEDMB, R5F565NEDMB_DUAL,(Debug 
Support Only) 
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65W-A R5F565WE, R5F565WE_DUAL 

660 

R5F56604A, R5F56604B, R5F56604C, R5F56604D, R5F56604E, 
R5F56604F, R5F56604G, R5F56604H, R5F56609A, R5F56609B, 
R5F56609C, R5F56609D, R5F56609E, R5F56609F, R5F56609G, 
R5F56609H 

66N R5F566ND, R5F566ND_DUAL, R5F566NN, R5F566NN_DUAL 

66T R5F566TA, R5F566TAXXFL, R5F566TE, R5F566TEXXFL, 
R5F566TF, R5F566TK 

671 R5F56719, R5F56719_DUAL, R5F5671C, R5F5671C_DUAL, 
R5F5671E, R5F5671E_DUAL 

71M R5F571MF, R5F571MG, R5F571MJ, R5F571ML 
72M R5F572MD, R5F572MD_DUAL, R5F572MN, R5F572MN_DUAL 
72N R5F572ND, R5F572ND_DUAL, R5F572NN, R5F572NN_DUAL 
72T R5F572TF, R5F572TK 

- R0E5571MLDMBXX (Debug Support Only) 
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RZ 

A1 

R7S721000, R7S721000_DualSPI, R7S721001, 
R7S721001_DualSPI, R7S721010, R7S721010_DualSPI, 
R7S721011, R7S721011_DualSPI, R7S721020, 
R7S721020_DualSPI, R7S721021, R7S721021_DualSPI, 
R7S721030, R7S721030_DualSPI, R7S721031, 
R7S721031_DualSPI, R7S721034, R7S721034_DualSPI 

A2 
R7S921040, R7S921041, R7S921042, R7S921043, R7S921045, 
R7S921046, R7S921047, R7S921048, R7S921051, R7S921052, 
R7S921053, R7S921056, R7S921057, R7S921058 

A3M R9A07G066M04GBG 
A3UL R9A07G063U01GBG, R9A07G063U02GBG 
G1E R8A77450, R8A77450_Core1,(Debug Support Only) 
G1M R8A77430, R8A77430_Core1,(Debug Support Only) 

G2L 

R9A07G044C12GBG_CM33, R9A07G044C22GBG_CM33, 
R9A07G044L13GBG_CM33, R9A07G044L14GBG_CM33, 
R9A07G044L23GBG_CM33, R9A07G044L24GBG_CM33, 
R9A07G044LC_M33, R9A07G044L_M33 

G2LC R9A07G044C12GBG, R9A07G044C12GBG_CM33, 
R9A07G044C22GBG, R9A07G044C22GBG_CM33 

G2UL R9A07G043U11GBG_CM33, R9A07G043U12GBG_CM33 

G3E 

R9A09G047E27GBG, R9A09G047E37GBG 
R9A09G047E47GBG, R9A09G047E57GBG 
R9A09G047E28GBG, R9A09G047E38GBG, 
R9A09G047E48GBG, R9A09G047E58GBG 

G3S 

R9A08G045S33GBG, R9A08G045S33GBG_CM33, 
R9A08G045S37GBG, R9A08G045S37GBG_CM33,  
R9A08G045S31GBG, R9A08G045S31GBG_CM33, 
R9A08G045S35GBG, R9A08G045S35GBG_CM33 

N2L R9A07G084M04GBA, R9A07G084M08GBA, 
R9A07G084M04GBG, R9A07G084M08GBG 

N2H R9A09G087M04GBG, R9A09G087M08GBG, R9A09G087M24GBG, 
R9A09G087M28GBG, R9A09G087M44GBG, R9A09G087M48GBG 

T1 

R7S910001, R7S910002, R7S910006, R7S910007, R7S910011, 
R7S910013, R7S910015, R7S910015_M3, R7S910016, 
R7S910016_M3, R7S910017, R7S910017_M3, R7S910018, 
R7S910018_M3, R7S910025, R7S910026, R7S910027, R7S910028, 
R7S910035, R7S910036, R7S910101, R7S910102, R7S910106, 
R7S910107, R7S910111, R7S910113, R7S910115, R7S910115_M3, 
R7S910116, R7S910116_M3, R7S910117, R7S910117_M3, 
R7S910118, R7S910118_M3, R7S910125, R7S910126, R7S910127, 
R7S910128, R7S910135, R7S910136 

T1-M R7S910020, R7S910021, R7S910022, R7S910023, R7S910120, 
R7S910121, R7S910122, R7S910123 

T2H R9A09G077M04GBG, R9A09G077M08GBG, R9A09G077M24GBG, 
R9A09G077M28GBG, R9A09G077M44GBG, R9A09G077M48GBG 

T2L R9A07G074M01GBG, R9A07G074M04GBG, 
R9A07G074M05GBG, R9A07G074M08GBG 

T2M 

R9A07G075M01GFA, R9A07G075M05GFA, 
R9A07G075M01GFP, R9A07G075M05GFP, 
R9A07G075M21GBA, R9A07G075M22GBA, 
R9A07G075M24GBA, R9A07G075M26GBA, 
R9A07G075M27GBA, R9A07G075M28GBA, 
R9A07G075M22GBG, R9A07G075M24GBG, 
R9A07G075M26GBG, R9A07G075M28GBG 

T2ME R9A07G075M29GBA, R9A07G075M29GBG 
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V2H R9A09G057H41GBG, R9A09G057H42GBG, R9A09G057H44GBG, 
R9A09G057H45GBG, R9A09G057H46GBG, R9A09G057H48GBG 

V2L 

R9A07G054L13GBG, R9A07G054L13GBG_CM33,  
R9A07G054L17GBG_CM33,  
R9A07G054L23GBG, R9A07G054L23GBG_CM33, 
R9A07G054L27GBG_CM33, 
R9A07G054L14GBG, R9A07G054L14GBG_CM33, 
R9A07G054L17GBG_CM33, 
R9A07G054L24GBG, R9A07G054L24GBG_CM33, 
R9A07G054L28GBG_CM33 

V2N 
R9A09G056N41GBG, R9A09G056N42GBG, R9A09G056N45GBG, 
R9A09G056N46GBG 
R9A09G056N44GBG, R9A09G056N48GBG 

Synergy  

S1JA R7FS1JA783A01CFM, R7FS1JA783A01CNE, R7FS1JA783A01CNF, 
R7FS1JA782A01CBT, R7FS1JA783A01CFJ 

S124 
R7FS124762A01CLM, R7FS124763A01CFL, R7FS124763A01CFM, 
R7FS124772A01CLM, R7FS124773A01CFL, R7FS124773A01CFM, 
R7FS124773A01CNB, R7FS124773A01CNE, R7FS124773A01CNF 

S128 R7FS128782A01CLM, R7FS128783A01CFJ, R7FS128783A01CFL, 
R7FS128783A01CFM, R7FS128783A01CNE, R7FS128783A01CNG 

S3A1 
R7FS3A17C2A01CLK, R7FS3A17C3A01CFB, R7FS3A17C2A01CBJ, 
R7FS3A17C2A01CLJ, R7FS3A17C3A01CFM, 
R7FS3A17C3A01CFP, R7FS3A17C3A01CNB 

S3A3 
R7FS3A37A2A01CLK, R7FS3A37A3A01CFB, R7FS3A37A2A01CBJ, 
R7FS3A37A2A01CLJ, R7FS3A37A3A01CFP, R7FS3A37A3A01CFM, 
R7FS3A37A3A01CNB 

S3A6 
R7FS3A6782A01CLJ, R7FS3A6783A01CFL, R7FS3A6783A01CFM, 
R7FS3A6783A01CFP, R7FS3A6783A01CNB, R7FS3A6783A01CNE, 
R7FS3A6783A01CNF 

S3A7 
R7FS3A77C2A01CLK, R7FS3A77C3A01CFB, R7FS3A77C2A01CBJ, 
R7FS3A77C3A01CFP, R7FS3A77C2A01CLJ, R7FS3A77C3A01CFM, 
R7FS3A77C2A01CNB, R7FS3A77C3A01CNB 

S5D3 R7FS5D37A2A01CLJ, R7FS5D37A3A01CFP, R7FS5D37A3A01CFM, 
R7FS5D37A3A01CNB 

S5D5 R7FS5D57A2A01CLK, R7FS5D57A3A01CFB, R7FS5D57A3A01CFP, 
R7FS5D57C2A01CLK, R7FS5D57C3A01CFB, R7FS5D57C3A01CFP 

S5D9 

R7FS5D97C2A01CBG, R7FS5D97C3A01CFC, 
R7FS5D97C2A01CLK, R7FS5D97C3A01CFB, 
R7FS5D97C3A01CFP, 
R7FS5D97E2A01CBG, R7FS5D97E3A01CFC, 
R7FS5D97E2A01CLK, R7FS5D97E3A01CFB, R7FS5D97E3A01CFP 

S7G2 

R7FS7G27H2A01CBD, R7FS7G27G2A01CBD, 
R7FS7G27H2A01CBG, 
R7FS7G27G2A01CBG, R7FS7G27H2A01CFC, 
R7FS7G27H3A01CFC, 
R7FS7G27G2A01CFC, R7FS7G27G3A01CFC, 
R7FS7G27H2A01CLK, 
R7FS7G27G2A01CLK, R7FS7G27H3A01CFB, 
R7FS7G27G3A01CFB, R7FS7G27G3A01CFP 
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2.2 Smart Configurator Support 
 

Note: Code Generator and Smart Configurator are the features to generate code. Code Generator supports old devise. 
New devices are supported by Smart Configurator 
Code Generator : https://www.renesas.com/software-tool/code-generator-plug 
Smart Configurator : https://www.renesas.com/software-tool/smart-configurator 

Note: Smart Configurator is supported in Windows, Linux and Mac OS versions.  
RZ/A, RZ/G, RZ/V and RH850 are supported only in Windows and Linux. 
RZ/T, RZ/N, Synergy and RE are supported only in Windows. 

Family Group Devices 

RH850 

C1M-A2 R7F701275 

F1KH 
R7F701708, R7F701709, R7F701710, R7F701711, R7F701714, 
R7F701715 

F1KM 

R7F701644, R7F701645, R7F701646, R7F701647, R7F701648, 
R7F701649, R7F701650, R7F701651, R7F701652, R7F701653, 
R7F701684, R7F701685, R7F701686, R7F701687, R7F701688, 
R7F701689, R7F701690, R7F701691, R7F701692, R7F701693, 
R7F701694, R7F701695, R7F701760, R7F701762, R7F701764 

U2A16 R7F702300, R7F702300A, R7F702300B 
U2A6 R7F702302 
U2A8 R7F702301, R7F702301A, R7F702301B 
U2B6 R7F70255x 

U2B6-E R7F7025Dx 
U2C2 R7F702615A 
U2C4 R7F702606A 
U2C8 R7F702600A 

RISC-V MCU  G021 R9A02G021 

RL78 

F22 R7F122F7G, R7F122FBG, R7F122FGG 
F23 R7F123FBG, R7F123FGG, R7F123FLG, R7F123FMG 
F24 R7F124FBJ, R7F124FGJ, R7F124FLJ, R7F124FMJ, R7F124FPJ 

- R7F125FGL, R7F125FLL, R7F125FML, R7F125FPL 

G15 
R5F12007, R5F12008, R5F12017, R5F12018, R5F12047, R5F12048, 
R5F12067, R5F12068 

G16 
R5F1211A, R5F1211C, R5F1214A, R5F1214C, R5F1216A, 
R5F1216C, R5F1217A, R5F1217C, R5F121BA, R5F121BC 

G22 

R7F102G4C, R7F102G4E, R7F102G6C, R7F102G6E, R7F102G7C, 
R7F102G7E, R7F102G8C, R7F102G8E, R7F102GAC, R7F102GAE, 
R7F102GBC, R7F102GBE, R7F102GCC, R7F102GCE, R7F102GEC, 
R7F102GEE, R7F102GFC, R7F102GFE, R7F102GGC, R7F102GGE 

G23 

R7F100GAF, R7F100GAG, R7F100GAH, R7F100GAJ, R7F100GBF, 
R7F100GBG, R7F100GBH, R7F100GBJ, R7F100GCF, R7F100GCG, 
R7F100GCH, R7F100GCJ, R7F100GEF, R7F100GEG, R7F100GEH, 
R7F100GEJ, R7F100GFF, R7F100GFG, R7F100GFH, R7F100GFJ, 
R7F100GFK, R7F100GFL, R7F100GFN, R7F100GGF, R7F100GGG, 
R7F100GGH, R7F100GGJ, R7F100GGK, R7F100GGL, 
R7F100GGN, R7F100GJF, R7F100GJG, R7F100GJH, R7F100GJJ, 
R7F100GJK, R7F100GJL, R7F100GJN, R7F100GLF, R7F100GLG, 
R7F100GLH, R7F100GLJ, R7F100GLK, R7F100GLL, R7F100GLN, 
R7F100GMG, R7F100GMH, R7F100GMJ, R7F100GMK, 
R7F100GML, R7F100GMN, R7F100GPG, R7F100GPH, R7F100GPJ, 
R7F100GPK, R7F100GPL, R7F100GPN, R7F100GSJ, R7F100GSK, 
R7F100GSL, R7F100GSN 

G24 

R7F101G6E, R7F101G6G, R7F101G7E, R7F101G7G, R7F101G8E, 
R7F101G8G, R7F101GAE, R7F101GAG, R7F101GBE, R7F101GBG, 
R7F101GEE, R7F101GEG, R7F101GFE, R7F101GFG, R7F101GGE, 
R7F101GGG, R7F101GJE, R7F101GJG, R7F101GLE, R7F101GLG 

  

https://www.renesas.com/software-tool/code-generator-plug
https://www.renesas.com/software-tool/smart-configurator
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L23 

R7F100LFE, R7F100LFG, R7F100LFJ, R7F100LFL, R7F100LGE, 
R7F100LGG, R7F100LGJ, R7F100LGL, R7F100LJE, R7F100LJG, 
R7F100LJJ, R7F100LJL, R7F100LLE, R7F100LLG, R7F100LLJ, 
R7F100LLL, R7F100LMG, R7F100LMJ, R7F100LML, R7F100LPG, 
R7F100LPJ, R7F100LPL 

RX 

110 R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110J 

111 
R5F51111, R5F51113, R5F51114, R5F51115, R5F51116, R5F51117, 
R5F51118, R5F5111J 

113 R5F51135, R5F51136, R5F51137, R5F51138 

130 
R5F51303, R5F51305, R5F51305B, R5F51306, R5F51306B, 
R5F51307, R5F51308 

13T R5F513T3, R5F513T5 
140 R5F51403, R5F51405, R5F51406 
14T R5F514T5 
230 R5F52305, R5F52306 
231 R5F52315, R5F52316, R5F52317, R5F52318 

23E-A R5F523E5A, R5F523E5S, R5F523E6A, R5F523E6S 
23E-B R5F523E5B, R5F523E6B 
23T R5F523T3, R5F523T5 
23W R5F523W7, R5F523W8 
24T R5F524T8, R5F524TA, R5F524TB, R5F524TC, R5F524TE 
24U R5F524UB, R5F524UC, R5F524UE 
260 R5F52606, R5F52607, R5F52608 
261 R5F52616, R5F52617, R5F52618 

26T 
R5F526T8, R5F526T9, R5F526TA, R5F526TB, R5F526TF, 
R5F526TF_DUAL 

64M R5F564MF, R5F564MG, R5F564MJ, R5F564ML 

651 
R5F56514, R5F56517, R5F56519, R5F5651C, R5F5651C_DUAL, 
R5F5651E, R5F5651E_DUAL 

65N 
R5F565N4, R5F565N7, R5F565N9, R5F565NC, R5F565NC_DUAL, 
R5F565NE, R5F565NE_DUAL 

660 

R5F56604A, R5F56604B, R5F56604C, R5F56604D, R5F56604E, 
R5F56604F, R5F56604G, R5F56604H, R5F56609A, R5F56609B, 
R5F56609C, R5F56609D, R5F56609E, R5F56609F, R5F56609G, 
R5F56609H 

66N R5F566ND, R5F566ND_DUAL, R5F566NN, R5F566NN_DUAL 
66T R5F566TA, R5F566TE, R5F566TF, R5F566TK 

671 
R5F56719, R5F56719_DUAL, R5F5671C, R5F5671C_DUAL, 
R5F5671E, R5F5671E_DUAL 

71M R5F571MF, R5F571MG, R5F571MJ, R5F571ML 
72M R5F572MD, R5F572MD_DUAL, R5F572MN, R5F572MN_DUAL 
72N R5F572ND, R5F572ND_DUAL, R5F572NN, R5F572NN_DUAL 
72T R5F572TF, R5F572TK 

RZ 
A2 

R7S921040, R7S921041, R7S921042, R7S921043, R7S921045, 
R7S921046, R7S921047, R7S921048, R7S921051, R7S921052, 
R7S921053, R7S921056, R7S921057, R7S921058 

A3M R9A07G066M04GBG 
A3UL R9A07G063U01GBG, R9A07G063U02GBG 
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N2L R9A07G084M04GBA, R9A07G084M08GBA, 
R9A07G084M04GBG, R9A07G084M08GBG 

N2H R9A09G087M04GBG, R9A09G087M08GBG, R9A09G087M24GBG, 
R9A09G087M28GBG, R9A09G087M44GBG, R9A09G087M48GBG 

T2H R9A09G077M04GBG, R9A09G077M08GBG, R9A09G077M24GBG, 
R9A09G077M28GBG, R9A09G077M44GBG, R9A09G077M48GBG 

T2L R9A07G074M01, R9A07G074M04, R9A07G074M05, 
R9A07G074M08 

T2M 

R9A07G075M01GFA, R9A07G075M05GFA, 
R9A07G075M01GFP, R9A07G075M05GFP, 
R9A07G075M21GBA, R9A07G075M22GBA, 
R9A07G075M24GBA, R9A07G075M26GBA, 
R9A07G075M27GBA, R9A07G075M28GBA, 
R9A07G075M22GBG, R9A07G075M24GBG, 
R9A07G075M26GBG, R9A07G075M28GBG 

T2ME R9A07G075M29GBA, R9A07G075M29GBG 

G2L 

R9A07G044C12GBG_CM33, R9A07G044C22GBG_CM33, 
R9A07G044L13GBG_CM33, R9A07G044L14GBG_CM33, 
R9A07G044L23GBG_CM33, R9A07G044L24GBG_CM33, 
R9A07G044LC_M33, R9A07G044L_M33 

G2LC R9A07G044C12GBG, R9A07G044C12GBG_CM33, 
R9A07G044C22GBG, R9A07G044C22GBG_CM33 

G2UL R9A07G043U11GBG_CM33, R9A07G043U12GBG_CM33 

G3E 

R9A09G047E27GBG, R9A09G047E37GBG 
R9A09G047E47GBG, R9A09G047E57GBG 
R9A09G047E28GBG, R9A09G047E38GBG, 
R9A09G047E48GBG, R9A09G047E58GBG 

G3S R9A08G045S33GBG_CM33, R9A08G045S37GBG_CM33,  
R9A08G045S31GBG_CM33, R9A08G045S35GBG_CM33 

G2UL R9A07G043U11GBG_CM33, R9A07G043U12GBG_CM33 

V2H R9A09G057H41GBG, R9A09G057H42GBG, R9A09G057H44GBG, 
R9A09G057H45GBG, R9A09G057H46GBG, R9A09G057H48GBG 

V2L 

R9A07G054L13GBG, R9A07G054L13GBG_CM33,  
R9A07G054L17GBG_CM33,  
R9A07G054L23GBG, R9A07G054L23GBG_CM33, 
R9A07G054L27GBG_CM33, 
R9A07G054L14GBG, R9A07G054L14GBG_CM33, 
R9A07G054L17GBG_CM33, 
R9A07G054L24GBG, R9A07G054L24GBG_CM33, 
R9A07G054L28GBG_CM33 

V2N 
R9A09G056N41GBG, R9A09G056N42GBG, R9A09G056N45GBG, 
R9A09G056N46GBG 
R9A09G056N44GBG, R9A09G056N48GBG 

Synergy 

S1JA R7FS1JA783A01CFM, R7FS1JA783A01CNE, R7FS1JA783A01CNF, 
R7FS1JA782A01CBT, R7FS1JA783A01CFJ 

S124 
R7FS124762A01CLM, R7FS124763A01CFL, R7FS124763A01CFM, 
R7FS124772A01CLM, R7FS124773A01CFL, R7FS124773A01CFM, 
R7FS124773A01CNB, R7FS124773A01CNE, R7FS124773A01CNF 

S128 R7FS128782A01CLM, R7FS128783A01CFJ, R7FS128783A01CFL, 
R7FS128783A01CFM, R7FS128783A01CNE, R7FS128783A01CNG 

S3A1 
R7FS3A17C2A01CLK, R7FS3A17C3A01CFB, R7FS3A17C2A01CBJ, 
R7FS3A17C2A01CLJ, R7FS3A17C3A01CFM, 
R7FS3A17C3A01CFP, R7FS3A17C3A01CNB 

S3A3 
R7FS3A37A2A01CLK, R7FS3A37A3A01CFB, R7FS3A37A2A01CBJ, 
R7FS3A37A2A01CLJ, R7FS3A37A3A01CFP, R7FS3A37A3A01CFM, 
R7FS3A37A3A01CNB 



e² studio 2026-04.3 Release Documentation Release Note 

R20UT5849EG0100     Rev.1.00  Page 26 of 59 
22nd June 2026  

S3A6 
R7FS3A6782A01CLJ, R7FS3A6783A01CFL, R7FS3A6783A01CFM, 
R7FS3A6783A01CFP, R7FS3A6783A01CNB, R7FS3A6783A01CNE, 
R7FS3A6783A01CNF 

S3A7 
R7FS3A77C2A01CLK, R7FS3A77C3A01CFB, R7FS3A77C2A01CBJ, 
R7FS3A77C3A01CFP, R7FS3A77C2A01CLJ, R7FS3A77C3A01CFM, 
R7FS3A77C2A01CNB, R7FS3A77C3A01CNB 

S5D3 R7FS5D37A2A01CLJ, R7FS5D37A3A01CFP, R7FS5D37A3A01CFM, 
R7FS5D37A3A01CNB 

S5D5 R7FS5D57A2A01CLK, R7FS5D57A3A01CFB, R7FS5D57A3A01CFP, 
R7FS5D57C2A01CLK, R7FS5D57C3A01CFB, R7FS5D57C3A01CFP 

S5D9 

R7FS5D97C2A01CBG, R7FS5D97C3A01CFC, 
R7FS5D97C2A01CLK, R7FS5D97C3A01CFB, 
R7FS5D97C3A01CFP, 
R7FS5D97E2A01CBG, R7FS5D97E3A01CFC, 
R7FS5D97E2A01CLK, R7FS5D97E3A01CFB, R7FS5D97E3A01CFP 

S7G2 

R7FS7G27H2A01CBD, R7FS7G27G2A01CBD, 
R7FS7G27H2A01CBG, 
R7FS7G27G2A01CBG, R7FS7G27H2A01CFC, 
R7FS7G27H3A01CFC, 
R7FS7G27G2A01CFC, R7FS7G27G3A01CFC, 
R7FS7G27H2A01CLK, 
R7FS7G27G2A01CLK, R7FS7G27H3A01CFB, 
R7FS7G27G3A01CFB, 
R7FS7G27G3A01CFP 

RA 

RA0 
R7FA0E105, R7FA0E107, R7FA0E207, R7FA0E209, R7FA0L105, 
R7FA0L107 

RA2 

R7FA2A1AB, R7FA2A2AD, R7FA2A2BD, R7FA2E1A5, R7FA2E1A7, 
R7FA2E1A8, R7FA2E1A9, R7FA2E2A3, R7FA2E2A5, R7FA2E2A7, 
R7FA2E305, R7FA2E307, R7FA2L1A9, R7FA2L1AB, R7FA2L207, 
R7FA2L209, R7FA2T107 

RA4 

R7FA4C1BB, R7FA4C1BD, R7FA4E10B, R7FA4E10D, R7FA4E2B9, 
R7FA4L1BB, R7FA4L1BD, R7FA4M1AB, R7FA4M2AB, 
R7FA4M2AC, R7FA4M2AD, R7FA4M3AD, R7FA4M3AE, 
R7FA4M3AF, R7FA4T1B9, R7FA4T1BB, R7FA4W1AD 

RA6 

R7FA6E10D, R7FA6E10F, R7FA6E2B9, R7FA6E2BB, R7FA6M1AD, 
R7FA6M2AD, R7FA6M2AF, R7FA6M3AF, R7FA6M3AH, 
R7FA6M4AD, R7FA6M4AE, R7FA6M4AF, R7FA6M5AG, 
R7FA6M5AH, R7FA6M5BF, R7FA6M5BG, R7FA6M5BH, 
R7FA6T1AB, R7FA6T1AD, R7FA6T2AB, R7FA6T2AD, R7FA6T2BB, 
R7FA6T2BD, R7FA6T3BB R7SA6W1AE, R7SA6W1BE, 
R7SA6W1CE, R7SA6W2AE, R7SA6W2BE, R7SA6W2CE 

RA8 

R7FA8D1AF, R7FA8D1AH, R7FA8D1BF, R7FA8D1BH, R7FA8E1AF, 
R7FA8E2AF, R7FA8M1AF, R7FA8M1AH, R7FA8T1AF, R7FA8T1AH, 
R7JA8D2JR, R7JA8D2JS, R7JA8D2KR, R7JA8D2KS, R7JA8M2LR, 
R7JA8M2LS, R7JA8P1JR, R7JA8P1JS, R7JA8P1KR, R7JA8P1KS, 
R7JA8T2LR, R7JA8T2LS, R7KA8D2AD, R7KA8D2AF, R7KA8D2BD, 
R7KA8D2BF, R7KA8D2JF, R7KA8D2KF, R7KA8M2AD, 
R7KA8M2AF, R7KA8M2JF, R7KA8P1AD, R7KA8P1AF, 
R7KA8P1BD, R7KA8P1BF, R7KA8P1JF, R7KA8P1KF, R7KA8T2AD, 
R7KA8T2AF, R7KA8T2CD, R7KA8T2CF, R7KA8T2JF, R7KA8T2LF 
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3. Smart Manual Support 
Smart manual support is delivered independently of e² studio releases when available. The following devices are 
available as of April 2026: 

  

• RX110 

• RX111 

• RX113  

• RX130 

• RX13T 

• RX140 

• RX210 

• RX220  

• RX230  

• RX231 

• RX23E-A 

• RX23E-B 

• RX23W 

• RX24T 

• RX24U 

• RX260 

• RX261 

• RX26T 

• RX62G 

• RX62T 

• RX631 

• RX63N 

• RX63T 

• RX64M 

• RX651 

• RX65N 

• RX660 

• RX66N  

• RX66T 

• RX671 

• RX71M 

• RX72M 

• RX72N 

• RX72T 

• RL78/G10 

• RL78/G11 

• RL78/G12 

• RL78/G13 

• RL78/G14 

• RL78/G15 

• RL78/G16 

• RL78/G1F 

• RL78/G22 

• RL78/G23 

• RL78/G24 

• RL78/L12 

• RL78/L13 

• RL78/L23 

 

• RZ/A1H  

• RZ/A1L  

• RZ/A2M 

• RZ/N2H 

• RZ/N2L 

• RZ/T1 

• RZ/T2H 

• RZ/T2L 

• RZ/T2M 

• RZ/T2ME 

 

• DA1453x 

• DA1459x 

• DA1469x 

• DA1470x 

 

• RISC-VG021 

• RA0E1 

• RA0E2 

• RA0E3 

• RA0L1 

• RA2A2 

• RA2E1 

• RA2E2 

• RA2E3 

• RA2L1 

• RA2L2 

• RA2T1 

• RA4C1 

• RA4E1 

• RA4E2 

• RA4L1 

• RA4M2 

• RA4M3 

• RA4T1 

• RA6E1 

• RA6E2 

• RA6M4 

• RA6M5 

• RA6T2 

• RA6T3 

• RA8D1 

• RA8D2 

• RA8E1 

• RA8E2 

• RA8M1 

• RA8M2 

• RA8P1 

• RA8T1 

• RA8T2 
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To view the Smart Manual support in e² studio please use the following method: 

• Please open the Smart Manual view. Available on the Renesas Views->Solution Toolkit->Smart Manual menu 
from the Menu bar. 

• Then use the “Install new Smart Manual…” option seen in the figure below: 

 
• A dialog is then displayed which shows all available Smart Manuals. 
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4. What is new in the 2026-04.3 release? 
 

Component Device Description 

FSP Smart 
Configurator RA, RZ 

The performance of FSP Smart configurator was improved. 

The memory usage and speed were improved when using the editor for 
FSP Smart configurator. 

R365 RA 
Integration with R365 has been enhanced. 

Please see What's New in Renesas 365 | Renesas 365 for more details. 

CDT All 

The base Eclipse Platform for e2 studio has been updated to 2025-12. 
You can find a full list of improvements here: 
https://eclipse.dev/eclipse/markdown/?f=news/4.38/platform.md 

CDT has been updated to CDT 12.3. CDT LSP support is not enabled by 
default but can be configured if you are using the latest C++ standards. 
You can find a full list of improvements here: 
https://github.com/eclipse-cdt/cdt/blob/main/NewAndNoteworthy/CDT-
12.3.md 

E2/E2 Lite 

Emulator 
RA 

Some options for External flash download were added on the debug 
configuration of E2 and E2LITE emulator for RA devices. 

The option will work with FSP 6.3.0 or newer versions of FSP. 

Please see https://www.renesas.com/en/document/apn/ra-familly-
external-flash-library-tools for more details. 

Smart 
Configurator RX 

There are some improvements of SC RX: 

• BSP version is updated to 7.71 to synchronize with the Technical 
Update for RX660 

• GPT component API is updated to avoid enabling unnecessary 
protections (e.g. WP) 

J-Link 

Emulator 
RA, RZ, RX 

J-Link nickname is now displayed in the emulator selection dialog when 
available, making it easier to identify the connected board. 

When selecting an emulator: 

• If a nickname is set: the nickname will be shown in the J-Link 
Serial field. 

• If no nickname is set: the serial number will be shown instead. 

RL78 Simulator RL78 

Renesas RL78 SMS Command List view was supported with the following 
functions when debugging RL78 devices that supports SMS functions with 
Simulator: 

• Show list of SMS instructions and SMS PC 

• Support to turn On/Off the SMS debug function, refresh view, 
resume/trigger SMS execution, step SMS, set SMS PC 

https://www.renesas.com/en/renesas365/whats-new
https://eclipse.dev/eclipse/markdown/?f=news/4.38/platform.md
https://github.com/eclipse-cdt/cdt/blob/main/NewAndNoteworthy/CDT-12.3.md
https://github.com/eclipse-cdt/cdt/blob/main/NewAndNoteworthy/CDT-12.3.md
https://www.renesas.com/en/document/apn/ra-familly-external-flash-library-tools
https://www.renesas.com/en/document/apn/ra-familly-external-flash-library-tools
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5. Useful workarounds and information for this e² studio release 
 

Please visit the Renesas FAQ for e² studio for the latest up to date information: 

Online FAQ link. 

ID Component Workaround or information 
 Application When using the check for updates feature within e² studio and updating from 

7.0.x to 7.1.x the initial restart after the update fails. An error message is 
displayed. Subsequent launches of e² studio work without issue.  
 
This is caused by the update to Java. 
 

 SH support The Renesas SH device family is no longer supported in e² studio. 
 
If you need to use the SH device support, please use e² studio 5.4 or earlier. 
 

 Importing old 
projects into 
6.x 

All projects being migrated into the latest e² studio from e² studio 5.4 and 
earlier versions will need to be migrated to the new builder plugins. The new 
builder plugins have different user interface pages and different option IDs. 
 
Upon opening an older workspace, the following dialog would be displayed: 
 

Clicking OK will update the workspace to the newer e² studio. 
 
Importing an existing project to the workspace or opening a workspace with old 
projects will automatically start the legacy project upgrade procedure.  
 
If for some reason this process does not start it is also possible to launch the 
“Upgrade Legacy of e2 studio Projects…” from the project context menu. 
 

 
 

https://en-support.renesas.com/knowledgeBase/category/30528/subcategory/30539
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The automatic system pops up a message bubble in the bottom left of the e² 
studio application window. 
 

 
 
After selecting the menu item or clicking the bubble the following dialog will be 
shown: 
 

 
 
To upgrade the project, click the corresponding check box and then click 
Finish. Note, this will update the project to the latest build plugins and options. 
Before doing this, you should ensure your project is backed up as this 
operation is not reversible. 
 
It is possible to upgrade multiple projects in a single operation. 
 
For the GCC toolchains for RX, RL78 and GNUARM-NONE have been made 
to the build options which mean we cannot guarantee the same binary output 
after upgrade. Please consider this before upgrading. 
 
Another consideration for migration is that debug configurations when opened 
in 6.0 will also need to be migrated. The following message will be displayed. 
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Please ensure that your projects are backed up or in revision control before 
migration allowing you to return to older versions if required. 
 

 
 

Toolchain 
Management 
 

Before e² studio 6.0 the toolchain management facility automatically upgraded 
or downgraded the imported project to the latest tools installed on the host 
machine. 
 
This no longer happens in the latest e² studio. Instead the toolchain remains 
the same and user operation is the only way to change the toolchain version. 
 
This operation is now available within the build settings on the toolchain tab. 
An example of CCRX is shown below: 

 
If the particular toolchain version does not exist and build is performed, then an 
error message is displayed, and the build will fail. 

 RZ Toolchain The now legacy KPIT GNU ARM-NONE toolchain is still supported within the 
e² studio product but now using the gnuarmeclipse plugins. 
 
In addition RZ within e² studio now supports the GNU ARM Launchpad 
toolchain. Available from https://launchpad.net/gcc-arm-embedded. 
 
One drawback of this toolchain is that it does not have a standard library 
builder provided in the same manner as the legacy KPIT ARM-NONE 
toolchain. To use this feature for ARM Launchpad and gain access to the more 
efficient optlib libraries a further download is required. 
 
This can be downloaded within the e² studio installer or directly from here: 
https://llvm-gcc-renesas.com/rz/rz-download-toolchains/ 
 
Once integrated it is possible to integrate the library generator from the 
toolchain tab of the build settings page. 
 

https://launchpad.net/gcc-arm-embedded
https://llvm-gcc-renesas.com/rz/rz-download-toolchains/
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See “Create Library generator” option. Once checked the library generator 
(libgen) is added to the available tool settings. 
 

 QE 
compatibility 

If QE for TCP/IP V1.0.0 is used, please update it to V1.0.1. 
Other QE series can be used with e² studio 6.0. 
 
What is QE? 
https://www.renesas.com/qe 
 
Details of QE for TCP/IP 
https://www.renesas.com/qe-tcpip  
 

5954 Application If you experience the error message “org.eclipse.swt.SWTError: No more 
handles” this can be caused by certain multi-monitor software and the Eclipse 
framework. 
 
If this error occurs there are 2 workarounds: 

1. Use a single monitor display. 
2. Uninstall the multiple monitor software from your graphics chipset 

vendor and revert to the standard Windows multi-monitor feature. 
 

6981 RL78 
Debugging 

When debugging IAR C source file with an OCD emulator (E1), the Monitor 
program area (0x00002-0x00003) is used. 

Therefore, this area must be excluded from usable address space.  
Please add '-HFF' in the linker option. 
1. Open Property. 
2. Select [C/C++ build]-[Settings] at left side. 
3. Select 'IAR RL78 Xlink linker' at right side, add '-HFF' at the textbox 

'command'. 
Not doing this will cause problems with connection and download when using 
interrupts. 

NA Application If you are experiencing slow building of projects within e² studio there are some 
possibilities to improve. 
The system environment will attempt to find the make.exe tool via the system 
environment.  If you ensure the directory, make resides in is at the start of the 
path variable it will find it more quickly.  Especially important if there are 
network drives in the path. 

https://www.renesas.com/qe
https://www.renesas.com/qe-tcpip
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In the project properties, C/C++ Build tab, behavior tab you can switch on 
parallel build.  This will take advantage of the multi-cores on your host machine 
if it has them. 
 

NA RZ GCC In 3.0 the KPIT GCC RZ toolchain was supported at version 14.01.  This 
version is no longer supported within e² studio. 
 
KPIT modified the name of their ARM toolchain to be ARM-none-eabi to follow 
standard ARM naming convention like other GCC toolchain vendors. 
 
The ARM-none toolchain is available at versions 14.01, 14.02 and 16.01 from 
the www.gcc-renesas.com website.  The binaries in the 14.01 version are 
identical to those used in the 14.01 RZ toolchain. 
 
Once the toolchain is installed your projects will be imported and ported to 
ensure there is as little disruption as possible due to this change. 
 

NA KPIT GCC The KPIT toolchains are now no longer supported by the 
www.kpitgnutools.com website. Support is now available from the llvm-gcc-
renesas.com website. 
 
In addition, there are two new releases for the GNU toolchains for RX and 
RL78. These are now named Renesas GCC for RX and Renesas GCC for 
RL78. 
 
Both integrate into e² studio and can be selected from the project wizard. 
 

1922 Application Symptoms: Project fails to build in first instance after archive project import (not 
from HEW) 
 
Conditions: If an archived project is imported, it may fail to build the first time, 
due to a residual .d file. 
 
Workaround: Clean and Build a second time. 
 

2762 CODAN When using assembly code within a C source file, CODAN errors can be 
observed in the editor. Even though the project builds successfully, or even 
after rebuild index. 
 
Indexer buffer can be insufficient to process whole project. 
Please try giving larger values for the following configurations. 
 
Open preferences dialog through “Window”->” Preferences” menu. In “C/C++” -
> “Indexer” tree, you will indexer configuration as shown below: 

https://llvm-gcc-renesas.com/
https://llvm-gcc-renesas.com/
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Put larger values for each red-framed variables, then rebuild project or rebuild 
index.  

2728 GDB Step into does not always work when using the CC-RX 1.02.01 toolchain. 
 
To ensure this behaves correctly you will need to use CC-RX 2.00.00 or 
greater as this issue with the debug information is corrected in this release. 
 

5772 IAR Plugins The IAR Plugin Manager is included in e² studio and provides support for RX, 
RL78, RH850 and RZ (ARM). 
 
This tool simplifies installation and configuration of IAR toolchain plugins. You 
can access this though Help -> IAR Embedded Workbench plugin manager. 
 

6184 RL78/CC-RL 
debugging 

When the load module for RL78/G10 which created at CC-RL is debugged in 
E1, please specify the following option: 

[Linker] -> [Device] -> "Set enable/disable on-chip debug by link option 
7217 Application The restore default settings does not restore all the options set during project 

generation.  Instead, it sets the defaults to the base settings for the device 
family in use. 

7524 RZ/T1 
Debugging 

In a RZ/T1 RAM-based project, the "Reload" function does not work. 

Reloading or re-downloading during debugging resets the device and the RAM 
content is erased. 

To continue the debugging, disconnect and connect the debugger again. 

 Use spaces as 
tabs 

Eclipse and CDT both have settings for use spaces as tabs. The option on the 
Editor preferences page conflicts with the CDT formatter settings. 

To change the use spaces as tabs option in e² studio please use this page: 
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 Installer 

problems 
In some situations, the AVG virus checker appears to interfere with the e² 
studio installation process. If you experience such a problem, please 
temporarily disable the AVG tool and try the installation again. 

 Antivirus In some situations, the Norton anti-virus tool can interfere with the building of 
Renesas Synergy projects. If possible, please disable the antivirus program 
when building Renesas Synergy projects on systems with Norton Antivirus 
installed. 

 Green Hills 
RH850 
Projects 

When debugging the RH850 object built with the Green Hills compiler in e² 
studio, specify the following option for the compiler option: 
-gtws 
 
The GUI setting menu is as follows. 

[GHS C Compiler for V800 Standalone]-[Debugging Option] 

     "Generate Target-Walkable Stack" -> On 

If this option is not specified, Step Over and Step Return may not work 
properly. 

17052 Debugging When debugging using a project with duplicate filenames that are in different 
source folders problems can be seen with breakpoint setting. 

When a breakpoint is set at a source line in this file it will also stop at the same 
source line in the other same named file when execution passes through. 

18505 RZ debugging When debugging with RZ/T1 in certain situations you may experience 
problems stepping: 

 
If the following conditions are met: 

  
1. Code is located close to address 0x0  
2. There is very little library code included into the project  
3. There are unused functions in the program  

The possibility arises that the code cannot be debugged. This due to --gc-
sections linker option which removes the unused functions but not the related 
debug information. 

There are several solutions to this problem:  
a. disable --gc-sections until those functions are used  
b. remove the unused functions 
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 RZ GCC Build In the latest e² studio, the RZ import functionality has been improved. 
However, there are still possibilities of older projects causing problems when 
imported into e² studio. 

In older versions of the RZ build plugins the FPU option was not being handled 
correctly. When setting the “Soft” Floating point ABI the command line was still 
receiving –mfpu=vfpv3 incorrectly. This can now cause problems with older 
start-up code in older RZ projects. 

After import if you see an error relating to this please add –mfpu=vfpv3 to the 
“Other Assembler Flags” page of the Assembler tool. 

In addition, when migrating some RZ/A1 projects you may experience import 
problems unless you build the project in 5.4 first. 

  

 RZ DS-5 
Project Import 

When a DS-5 project is imported into e² studio the environment variables for 
Path and TCInstall are copied from the DS-5 environment.  
 
This is not correct. The way to correct this problem is to delete both paths and 
replace them with correct values to your toolchain. If you are unsure how to 
correct this, please create a new project and copy the values from this to the 
converted project.  

 RX & RL78 
GCC Project 
Import 

When importing a KPIT RL78/RX Library C/C++ project from e² studio 5.4 or 
before the build artifact settings are not correct. 
 
The output prefix should be set to “lib” but is in fact empty. 
 

 RZ/G debug In the case of debugging Linux application for RZ/G, the following error 
messages are shown in GDB server console when pushing [Step in] button or 
[Step Over] button. 
These messages can be ignored because the Step debugging should work 
properly even with these messages. 
 
Examples of error messages: 
 PassthroughTargetCommunication::sendResponse error 42 46 
 PassthroughTargetCommunication::sendResponse error 10 15 
 PassthroughTargetCommunication::sendResponse error 42 46 

21863 RX & RL78 
Debugging 

In previous releases there were some problems with stepping in some 
situations when using the CCRX and CCRL toolchains. 

 

A fix has been made to the debug object converter. To see this improvement 
please clean and rebuild the project. The debug information will then be 
updated, and the stepping will be more correct and reliable. 

 Code 
Generator 
registration 

When using multiple installations of e² studio on your machine you may find 
that subsequent installations do not work correctly with the code generator. 

The effect is that the code generator cannot be created or added to projects. 
Existing projects can be used by the code generator views appear empty. 

If this is the case, then the code generator must be manually registered. To do 
this execute the following tool: 

e.g.  
C:\Renesas\e2_studip\eclipse\plugins\com.renesas.cg_2.11.0.v201
80601-1047\CodeGenerator\Tools\register COM.bat 
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25278 Synergy 
debugging 

When loading Symbols from multiple .elf files compiled using the IAR 
toolchain, the user will need to add  ".text" before  place in FLASH_region 
command inside the .icf Script.  

e.g.  
".text":  
place in FLASH_region   { block LOCK_LOOKUP, 
               ro, 
               ro section .rodata, 
               block QSPI_NON_RETENTIVE_INIT_BLOCK, 
               block RAM_INIT_CODE, 
               block USB_DEV_DESC_BLK }; 

25273 RZ Device 
Migration 

When changing the device from a RZ/A1 and attempting to swap to a RZ/T1 
the device migration is not successful. 
 
The source code is not migrated successfully, and the build fails. 
This is due to the different start-up code structure between these devices. 
 
In this case please create a new project and copy the required source to the 
newly created project. 

25195 RZ/A2M Smart 
Configurator 

When creating a project of RZ / A2M, the following Warning is displayed in the 
Problems view for the src / renesas / configuration folder. 
    "Invalid project path: Include path not found" 
 
[Workaround] 
Delete the specification of this folder with the compile option include path 
setting. 

24883 R2/A2M RZ / A2M project generated by e² studio does not support GCC ARM 7.x or 
later. Please use GCC ARM 6.3. 

27913 GDB server 
RL78 

When debugging with an EZ cube, real-time refresh significantly slows down 
debugging features and it makes e² studio look like suspended. 

12123 Linker Script 
Editor 

The Linker Script Editor may report errors when using some Wild Identifiers 
such as 1file.o and *filename.o . 

Although these are valid file names and valid identifiers according to the Linker 
Script syntax, they need to be quoted when using the Linker Script Editor. 

(e.g. "1file.o" and "*filename.o"). 

 RZ/G Linux 
Platform Tools 

When using RZ/G Linux Platform Tools, gnu.io.rxtx plug-ins should be installed 
same as Nebula plug-ins.  

Please follow the below steps to install gnu.io.rxtx plug-ins. 

 

Start the e² studio and select [Help] -> [Install New Software] from the menu 
bar to open the [Install] dialog box.  

Click on the [Add] button, enter “GNU RXTX Plugin Update Site” as a name 
and “http://rxtx.qbang.org/eclipse/” as a location, and click on the [OK] button. 

 
 
Select [RXTX 2.1-7r4] -> [RXTX End-User Runtime] from the list, click on the 
[Next] button, confirm the license, and install the plug-ins. 
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32564 MyRenesas Due to differences in the login data between 7.8 and the 2020-04 e² studio (or 
later) version the FreeRTOS download feature does not work in 7.7/8 if the 
user has logged into MyRenesas or changed their login data details using 
2020-04. If you previously used 7.7/8 prior to using 2020-04 and have not 
changed your login details, then both versions will work correctly.  

If you need to use MyRenesas in older versions of e² studio after logging in 
using 2020-04 then you will need to close all e² studio instances and delete the 
file "%USERPROFILE%\.eclipse\org.eclipse.equinox.security\secure_storage". Be 
aware that doing this will remove stored passwords for any Eclipse-based 
application. 

32543 QE When updating e² studio versions using an installer any installed QE tools are 
removed and then must be reinstalled. To preserve QE tools during an update 
use the "Check for Updates" function in the "Help" menu to perform an in-place 
online update. 

30613 RH850 When viewing flash memory in the Memory View, it can be confusing as the 
values for this memory type can be random for unwritten blank flash memory 
regions.  

This can then result in many false positives for memory changes, resulting in 
more memory changes than expected. (red text)  

To fix this the debugger supports detection and filling of blank addresses areas 
with a user specified hex byte value.  

There is currently no user interface support for this feature. So, you need to 
add the following command parameters to the additional commands section of 
the debug configuration. The GDB command line option is: -
uBlankFlaskFill=BB with the blank fill value being 0xBB. Specifying this 
value enables the feature, by default it is off. 

37443 RA (Linux) CMSIS Pack Import feature does not work for RA on Linux 
36999 RA Deleting the Debug folder from an NS project causes build failure when 

reference NSC guard functions. 
36007 RA When debugging a secure and non-secure project - the Non-secure callable 

functions do not have debug information. 
This means you cannot set breakpoints in the secure function. 

35767 RA, RZ (Linux) When importing an image using the "Image" Rendering on Linux Host the 
action fails. If you need to import an image on Linux please use the Raw Image 
memory rendering instead. 

38324 RA When upgrading an e² studio 2020-04 or 2020-07 containing RA Family 
support to 2020-10 or later using the installer you may encounter on the 
features page. 
 
To avoid this, you either need to re-select RA on the Device Family selection 
page or uncheck and check again "Renesas FSP Smart Configuration Core" 
on the Features page. 
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IDE-
39932 

RX The Renesas ITRON debug views is only supported with e² studio 32bit 
version such as 7.8.0 currently. Enabling the Renesas ITRON debug views on 
e² studio 64bit version is under planning. 

IDE-
42025 

RL78 
After conversion of  legacy GCC projects to LLVM, the generated linker_script 
and start.S files should be moved to src folder. "generate" folder needs to be 
deleted and the path to the linker script from Settings-> Linker-> Linkerscript 
should be change to "${ProjDirPath}/src/linker_script.ld" 

 RA When migrating from FSP versions before 3.0 the way pin configuration files 
are handled has changed. Previously the projects maintained “.pincfg” files 
within the project directory which contained the pin data. 
When migrating to FSP 3.0 and the subsequently saving the migrated 
configuration.xml the pin data is migrated from these files to the 
configuration.xml file. 
The “.pincfg” files will still appear in the pin tab until they are subsequently 
removed. 

IDE-
44277 

All 
From e² studio 2021-07 the RTOS debugging integration has been switched off 
by default due to some debug stability problems. This feature can be unstable 
with some RA projects. If you wish to switch this back as it may work for you, 
you can do so from the debug configuration settings pages. This can be 
accessed via the Run->Debug Configurations menu item or via the project 
context menu Debug As->Debug Configurations. 
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IDE-
43524 

 Symbols of inline assembler instruction could not be resolved on C/CPP 
standard language. They can be resolved on Renesas C/CPP Language 
Extend. +Renesas C/CPP Language Extends are added in Language 
Mappings of new project on e² studio v2021-07. +Renesas C/CPP Language 
Extends need to be added manually, if old project is imported to e² studio 
v2021-07. 
 

 
 

IDE-
43405 

RA, Synergy 
Microsoft have updated and improved the TraceX tool which can now be 
downloaded from the Microsoft Store. If you are using a new version of TraceX 
when configuring the tool, ensure you have checked the "Use TraceX installed 
from Microsoft Store" option. If you are using an older version, then uncheck 
this box. The configuration dialog is available in the preferences dialog. 
(Window->Preferences) (Renesas->TraceX category) 

IDE-
34814 

RL78, RX 
The CCRX and CCRL build components now support multiple output formats 
for Converter tool instead of one format as previous version. If you migrate an 
old project to the new e² studio and then return to the old e² studio with the old 
output format. You will need to modify the settings as desired. 

IDE-
43454 

RA, RZ 

The Linux installer for  e² studio cannot be run as root by default, including 
using "sudo". If you wish to run it as root, then you need to add "--appimage-
extract-and-run" as the 1st argument. e.g., "sudo ./e2studio_installer-2021-
07.AppImage --appimage-extract-and-run" 

IDE-
47790 

RH850 Synchronous mode is supported in  e² studio 2022-01 for debugging RH850 
multi-core devices. 
There is no need to manually switch between synchronous mode and 
asynchronous mode, and the mode automatically switches to the optimum 
mode depending on the debug operation. 
 
Basic specifications for mode switching: 
When all cores are stopped and [Resume All], the operation mode becomes 
synchronous mode. 
Resume for one core switches to asynchronous mode and continues in 
asynchronous mode until all cores have stopped. 
Always use sync mode under the following conditions: 
* In that case, the operation of the [Resume] button will be the same as the 
operation of the [Resume All] button. 
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-Software breakpoint has been set. 
-Connected with a hot plugin connection. 
-Connected with a Initial Stop State debugging enabled. 
 
Synchronous mode specifications: 
-The [Resume All] button executes all cores. 
-When a core is suspended due to a breakpoint or the [Suspend] button, all 
cores are suspend. 
-For the [Step Into] button, all cores will step in. 
-For the [Step Over] button, all cores will be executed. Then, when the 
currently active core completes the step over execution, all cores will be 
suspend. 
-For the [Step Return] button, all cores will be executed. Then, when the 
currently active core completes the step return execution, all cores will be 
suspend. 
 
Asynchronous mode specifications: 
-[Resume] button executes the currently active core. 
-Suspend on one core due to a breakpoint or the [Suspend] button does not 
affect the behavior of the other cores. 
-Unable to set software breakpoints. 
 
Specifications of each button related to execution control: 
 [Resume] button: Switch to asynchronous mode and run the core currently 
being debugged. 
 [Suspend] button: In asynchronous mode, stop the core currently being 
debugged. In synchronous mode, stop all cores. 
 [Resume all] button: Switch to synchronous mode and run all cores. 
 [Suspend all] button: Stop all cores and switch to synchronous mode. 
 
Limitations: 
-When use Step Into in synchronous mode, cores that are not debugged are 
also stepped, but the execution addresses of those cores are not reflected in 
the debug view. Check the register view for the correct PC value. 

IDE-
48013 

RX The following BSP packages have been removed from the RX Smart 
Configurator:  
 
• r_bsp_gcc_v1.00.zip 

• r_bsp_gcc_v1.10.zip 

• r_bsp_gcc_v1.20.zip 

• r_bsp_gcc_v1.30.zip 

• r_bsp_iar_v1.00.zip 

• r_bsp_iar_v1.10.zip 

• r_bsp_iar_v1.20.zip 

• r_bsp_user_v1.10.zip 

• r_bsp_user_v1.20.zip 

• r_bsp_user_v1.30.zip 

• r_bsp_v3.80.zip 

• r_bsp_v3.91.zip 

• r_bsp_v4.00.zip 
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• r_bsp_v4.01.zip 

• r_bsp_v5.20.zip 

• r_bsp_v5.21.zip 

• r_bsp_v5.40.zip 

• r_bsp_v5.50.zip 

• r_bsp_v5.61.zip 

• r_bsp_v5.62.zip 

• r_bsp_v5.63.zip 

• r_bsp_v5.64.zip  

 
To continue using the above listed BSP packages, please use the download 
function in Smart Configurator to download the exact version. 

IDE-
46896 

GCC Plugins 
Projects imported from Windows fail when being built in Linux. 
 
If copying a project with its build output directory between Windows & Linux, or 
moving it to a new location, you need to do a clean and rebuild to avoid build 
errors.  
 
If storing a project under version control avoid including the build output 
directories. At a minimum exclude the *.d files which may contain system 
specific paths. 

 FSP Smart 
Configurator 

When using the FSP Smart Configurator the linker script is now generated in 
the build configuration folder rather than the script folder. 
 
This change should be automatically picked up when the project content is 
generated from the FSP Smart Configurator tool. This should ensure that 
existing projects continue to work as expected. 
 
When using the IAR toolchain for your project this new behavior can cause 
issues. In this case the IAR linker uses the “memory_regions.icf” file available 
in the script folder rather than the script file generated in the build 
configurations folder. To work around this please delete the file present in the 
script folder, then the tool will use the file in the build configuration folder. 

IDE-
55553 

RL78 GCC 
The RL78 GCC toolchain has been deprecated in favor of the RL78 LLVM 
toolchain. This toolchain offers much better performance and is recommended 
for new projects. 

IDE-
59034 

Synergy 
Configurator The Synergy Package view will need to be opened manually from version 

2023-01 onwards, as it is not opened by default (since Synergy now uses a 
different Pin Configurator than in earlier e² studio versions). The Synergy 
Package view is named "Synergy Package (experimental)". 
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 Synergy 
Configurator Renesas Synergy no longer supports Synergy Software Platform (SSP) 

version 1.x. 
 
Only Synergy Software Platform (SSP) version 2.0 and later will be available 
for new Synergy projects. Existing Synergy 1.x projects will prompt to upgrade 
upon opening them in the Synergy Configurator, if a later version (2.0 or later) 
is available. 
This means that it is no longer possible to build SSP 1.x projects in  e² studio 
2023-01. 

 Synergy 
Configurator 

The Pin Editor component for Renesas Synergy projects has been modified to 
use the same pin configurator as the RA device family. 
Any existing projects that were using the Synergy Pin Editor will have their 
projects automatically upgraded upon opening them in the Renesas Synergy 
Configurator. 
This will allow Synergy users to access the more advanced feature set of the 
RA pin configurator and enjoy an updated user experience. 

IDE-
62045 

GreenHills  
Plugins for GHS Multi are no longer installed with e² studio. Please see the 
GHS Multi manual for instructions on how to install the plugins if you want to 
use them. 
 

IDE-
61688 

Application  
Toolbar buttons with functions that are accessible via a menu item have been 
hidden by default for new workspaces. You can add them back via Windows -> 
Perspective -> Customize Perspective This change will not impact 
perspectives in existing workspaces unless the perspective is reset. 
 

IDE-
66781 

Reality AI 
integration The base production URL of Reality AI is changed. So e² studio 2023-01, 

2023-04 and 2023-07 versions can no longer use Reality AI functionalities. 

IDE-
59440 

Debugging RA Disconnect an RA board with the "Continue" option (allowing the user code to 
execute after disconnecting from JLink) does not work when using 
semihosting.  
 
To work around this, make sure you have conditional code for when the 
debugger is not connected, e.g.  
 
semihosting_printf( ... ) 
{ 
   if (CoreDebug->DHCSR & CoreDebug_DHCSR_C_DEBUGEN_Msk) 
   { 
      printf( ... ); 
   } 
} 
 
#if semihosting 
   #SAFE_PRINTF( ... )   semihosting_printf( ... ) 
#else 
   #SAFE_PRINTF( ... )   printf( ... ) 
#endif 
 
Additionally, the use of an updated hard-fault handler to catch this situation 
would also help. 
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IDE-
68935 

Installer  
Installation for all users and running e² studio from the installer can cause 
problems with access to support files and workspace locations.  
 
This issue occurs when a local administration user installs e² studio and runs 
for the first time. If this user also creates a workspace, subsequent different 
users with lower privileges may experience problems when trying to open that 
workspace.  
 
Depending on installation configuration you may see an error like "Error 
extracting synergy support files". To avoid this issue subsequent users should 
create a new workspace. 
 

IDE-
69167 

Installer When installing the platform installer for RA on Windows you may experience 
issues with GCC toolchain compilation if e² studio is installed in a long path.  
 
Examples problems include not being able to find system include header files. 
The workaround for this issue is to install e² studio in a shorter directory 
structure. 
 
e.g., 
c:\users\username\appdata\local\programs\renesas\e2_studio\toolchains\gcc_
arm\arm-gnu-toolchain-12.2.mpacbti-rel1-mingw-w64-i686-arm-none-eabi  
to  
c:\renesas\e2_studio\toolchains\gcc_arm\arm-gnu-toolchain-12.2.mpacbti-rel1-
mingw-w64-i686-arm-none-eabi 

IDE-
76022 

RA Debugging 
RTOS threads may not correctly show call stacks when stepped after being 
Paused. Linux only. 

IDE-
78715 

Installation Installation of e2 studio 2024-07 on Windows 11 Enterprise 23H2. 
 
If you experience issues installing e2 studio on a very newly installed Windows 
image. You will see an error "Unable to connect to Renesas website. 
Installation may continue but some functions may not be available." Items such 
as toolchain download during installation cannot be accessed. Please try this: 
Run this command as admin resolve the issue: CertUtil -VerifyCTL AuthRoot 
 

IDE-
81939 

RA Standalone 
Configurator Specifically, to the FSP standalone configurator on Linux OS, FSP projects for 

use with the EWARM IDE will not be buildable due to an issue with the pre-
build and post-build steps when building the project. 

IDE-
89966 

Application Some users may see issues with browser-based content, e.g. Help. If closing 
& reopening the view does not fix the issue then the line 
"chromium.integration.eclipse.disable=true" should be added to the end of 
"configuration/config.ini" in the install directory of e2 studio 

IDE-
93506 

RA Debugging When debugging RA with ARM compiler, an error that says "Failed to execute 
MI command" for load command may be displayed on connection. 
In this case, please remove '0' from "Offset (hex)" for the "Load Image and 
symbols" on the debug configuration. 

IDE-
93580 

RA Debugging When debugging RA devices with LLVM toolchains, the PC address may point 
to the incorrect file/line. It will not affect the actual code and it may be improved 
by changing the optimization level. 

IDE-
93684 

RL Debugging The default projects generated using Smart Configurator for RL78/F2x devices 
have the default value for Flash serial programming security ID 
0xFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFE not same as default security ID 
(0xFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF) of the device. This mismatch 
causes failing to authenticate when flashing to device. As a result, we cannot 
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debug with it. To able to debug with it: 
- Please change the option on Debug Configuration, "Permit rewrite the serial 
programming security ID" to Yes. Please note that after debugging with above 
option changed, the flash serial programming security ID on the device will 
change to FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFE. 

IDE-
93871 

RZ Debugging When debugging CR52_1 on RZ/T2H, the debug connection may fail with the 
default lauch settings. In this case, please specify "Prevent Releasing the 
Reset of the CM3 core" to 'Yes'. 
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6. Linux version 
6.1 How to install 
For information on how to install the Linux product please refer to FAQ below. 

English : https://en-support.renesas.com/knowledgeBase/19934358 
Japanese : https://ja-support.renesas.com/knowledgeBase/19934356 
 

6.2 How to run 
A. Run ‘terminal’ application of Linux. 
B. Move installed directory and Run ‘e² studio’ binary file. 

6.3 Register toolchain to e² studio 
6.3.1 Renesas C Compiler (CC-RX / CC-RL / CC-RH) 
If you want to use the Renesas C Compiler (CC-RX / CC-RL / CC-RH), you will need to obtain an installer for the 
toolchain and install and register it with the e² studio. 

1. Downloading Renesas C Compiler and Renesas License Manager 

The Renesas C Compiler installer is available from Renesas product page below. 

 CC-RX 
https://www.renesas.com/software-tool/cc-compiler-package-rx-family 

 CC-RL 
https://www.renesas.com/software-tool/c-compiler-package-rl78-family 

 CC-RH 
https://www.renesas.com/software-tool/c-compiler-package-rh850-family 

In addition, the Renesas License Manager is necessary to use Renesas C Compiler as licensed edition. Also, Renesas C 
Compiler can be used without the Renesas License Manager. In this case, the Renesas C Compiler will work as an 
evaluation edition. The Renesas License Manager for Linux is available from the product page above. If you would like 
to know more about license, please see the following page. 

https://www.renesas.com/software-tool/compiler-licenses 

 

2. Installing Renesas C Compiler and Renesas License Manager 

Please refer to the text file enclosed in the Renesas C Compiler and the Renesas License Manager for the Renesas C 
Compiler and the Renesas License Manager installation. 

And license registration is described in the Release Note of the Renesas License Manager. Please refer it. 

 

3. Registering Renesas C Compiler 

After the Renesas C Compiler installation is complete, start e² studio, execute the [Help – Add Renesas Toolchains] 
menu, and select "Add..."Press the button and enter the path where the Renesas C Compiler is installed to register. 

https://en-support.renesas.com/knowledgeBase/19934358
https://ja-support.renesas.com/knowledgeBase/19934356
https://www.renesas.com/software-tool/cc-compiler-package-rx-family
https://www.renesas.com/software-tool/c-compiler-package-rl78-family
https://www.renesas.com/software-tool/c-compiler-package-rh850-family
https://www.renesas.com/software-tool/compiler-licenses
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6.3.2 GNU ARM Embedded 
Install the GNU ARM Embedded toolchain to a shared folder as follows: 
sudo mkdir -p /opt 

cd /opt 

sudo tar jxf ~/Downloads/gcc-arm-none-eabi-7-2018-q2-update-linux.tar.bz2 

(assuming the toolchain has been downloaded to your Downloads folder) 

On first invocation you will be prompted to specify a workspace location, you will also be advised that there 
are no new toolchains available for integration. Open the Renesas Toolchain Management preference page 
using the Help → Add Renesas Toolchains menu item, then click on the Add... button and navigate to the root 
folder of the GNU ARM Embedded toolchain installation at /opt/gcc-arm-none-eabi-7-2018-q2-update in order 
to register the toolchain with e² studio: 
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6.3.3 Linaro 
A. Download and extract a toolchain package file to arbitrary directory. 
B. Run ‘e² studio’ and select ‘Help – Add Renesas Toolchains’ 
C. Select ‘Toolchain Type’ and ‘Add’ Location of toolchain. 

 

 
Figure 2.   Register Toolchain: Browse toolchain location 

D. Click checkbox of added toolchain and restart e² studio. 

 
Figure 3.   Register Toolchain: ex) Linaro  
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6.4 How to build and debug RA applications Overview 
6.4.1 Build 

Open the New project wizard and choose an RA project. 

If this is unavailable it is likely the FSP has not been installed correctly. In this case, quit e² studio, reinstall the 
pack(s) and restart e² studio again. 

Once the wizard completes a sample project will have been created, as well as a debug configuration for 
connecting the debugger. 

6.4.2 Debug 
Once the project has successfully built and produced a build artefact for debug, open the Debug Configurations 
dialog and a browse to the Renesas Hardware Debug section. 

The debug configuration will match the project name – check that the settings are correct and hit Debug to 
connect to the device. 

Checks if connection fails. 

If the debug connection fails, it is often for one of two reasons: 

1. If using a virtual machine, make sure that the device is tied into the VM rather than the host machine. 

2. If the Segger library has not installed as part of the FSP correctly open the 
“/home/user/.eclipse/com.renesas.platform_XXXXXXX/DebugComp/RA/ARM/Segger” 
folder and copy and paste the 'libjlinkarm.so' into the other Segger folders - e.g. 'Segger_v6.50.1’. 
Alternatively, take the latest file from the Segger Tools installation folder and install it in the same 
place. 
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6.5 How to build and debug RZ Linux application Overview 
e² studio for Linux supports building and debugging Linux applications for devices of RZ/A Group and RZ/G 
Group. For debugging by GDB (the GNU Project Debugger), please add Linux programs gdb-server program to 
Linux file system of devices and run as background process automatically. (ssh-server, tcf-agent will be needed for 
connection between host system and target device.) For detail about building Linux image for RZ family devices, 
refer to embedded Linux wiki pages (https://elinux.org) or Renesas Rulz web pages about RZ family 
(https://community.renesas.com/). Descriptions in below is based on RZ/A1H case. 

 
6.5.1 How to add gdb-server to RZ/A Linux root file system 

A. Build root file system of RZ/A1 Linux-4.9 BSP. 
(path example: ~/rza_linux-4.9_bsp/, command example: ./build.sh buildroot) 

B. Move to ‘buildroot-***’ directory in ‘output’. 
(path example : ~/rza_linux-4.9_bsp/output/buildroot-2017.02) 

C. Run menuconfig (make menuconfig) and add gdb-server.  
(Select ‘Toolchain－Copy gdb server to the Target’ menu) 

 
Figure 4.   Menuconfig: set ‘copy gdb server to the target’ 

 
D. Move to ‘target’ directory in ‘output’ of ‘buildroot-****’.  

(path example: ~/rza_linux-4.9_bsp/output/buildroot-2017.02/output/target) 

E. Add new file with a line as command at ‘/etc/init.d’ directory 

 
 

F. Delete or disable below contents from etc/inittab. 

 
 
G. Move ‘Linux-4.9 BSP root’ (path example: ~/rza_linux-4.9_bsp/) and build root file system again. Download 

root file system at target device.   

File name: S51gdbserver 

Command: /usr/bin/gdbserver --multi --remote-debug /dev/ttySC0 

# Put a getty on the serial port 

# ttySC0::respawn:/sbin/getty -L ttySC0 115200 vt100 # GENERIC_SERIAL 

https://elinux.org/
https://community.renesas.com/
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6.5.2 Linux C/C++ Project generation and build 
A. Connect target device which is run as Linux, via Serial port.  
B. Select ‘File – New - RZ Linux C/C++ project’ menu and make new RZ/A1H Linux C/C++ project. In phase 

of ‘RZ Linux connection settings’, the serial port which is used for connecting target device, will be selected 
automatically.  

 
Figure 5.   New RZ Linux project & connection setting: Serial port 

C. After editing codes, build by selecting ‘Build Project’ in right-click menu or push   button.  

 
Figure 6.   Build Project 
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6.5.3 GDB debug by using serial port communication  
A. Terminate all processes use serial port communication such as Minicom. 
B. Open ‘Configuration’ and check ‘Serial’ is selected as ‘Connection’. 

 
Figure 7.   Connection configuration: Serial 

C. Run debug by push button    . It takes 10 or more seconds for transferring binary files to target device. 
Pop up message for switching to debug perspective will be shown after transferring binary files. 

 
Figure 8.   Debug: Perspective Switch 
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D. ‘Debug Perspective’ provides ways for flow control and configurations. 

 

 Figure 9.   Debug: Control buttons, views, setting break point 
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7. Open Issues 
 
Open issues in the e² studio product will be kept up to date here: 
Please visit to see the latest open issue list. 
 
  

https://www2.renesas.eu/_custom/software/ree_eclipse/e2studio10/docs/releasenotes/2026_0403/openissues.html
https://www2.renesas.eu/_custom/software/ree_eclipse/e2studio10/docs/releasenotes/2026_0403/openissues.html
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8. Appendix 
8.1 Website and Support  
Renesas Electronics Website 

http://www.renesas.com/ 
 
Inquiries 

http://www.renesas.com/contact/ 
 

8.2 Web Access and Privacy Policy 
Collection of User Information Applications included in this package may access the Renesas Web site. In such cases, 
the following information is collected and recorded to Renesas server as a log. 

• Date and time of access 

• Access to URLs and files 

• The unique certificate number linked to your account for MyRenesas (only when you log in to MyRenesas) 

• The unique identification number linked to cookies for the Web browser (for cookies, refer to the privacy policy page 
stated below). 

Logs are managed based on our privacy policy. 

Refer to our privacy policy on the following Web page. 

Privacy Policy: 

https://www.renesas.com/privacy.html 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

  

http://www.renesas.com/
http://www.renesas.com/contact/
https://www.renesas.com/privacy.html
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9. Revision History 

Rev. Date 
Description 
Page Summary 

1.00 22th June 2026 - First Edition. 
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1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and 

application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your product or 
system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of these circuits, software, 
or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or other 
intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this document, including 
but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others. 
4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, manufacture, 

sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 
5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability 

for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 
6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for each Renesas 

Electronics product depends on the product’s quality grade, as indicated below. 
 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic 

appliances; machine tools; personal electronic equipment; industrial robots; etc. 
 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial 

terminal systems; safety control equipment; etc. 
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics 
document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to human life or bodily injury 
(artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system; undersea repeaters; nuclear power 
control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all liability for any damages or losses 
incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual 
or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics hardware or 
software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not limited to any 
unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS ELECTRONICS DOES NOT 
WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING RENESAS ELECTRONICS 
PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, HACKING, DATA LOSS OR THEFT, OR 
OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND ALL RESPONSIBILITY OR LIABILITY 
ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT PERMITTED BY APPLICABLE LAW, 
RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO THIS DOCUMENT AND ANY 
RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF 
MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for Handling and 
Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect 
to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any 
malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics, 
such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability product or a product for harsh 
environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not subject to radiation resistance design. 
You are responsible for implementing safety measures to guard against the possibility of bodily injury, injury or damage caused by fire, and/or danger to the public in 
the event of a failure or malfunction of Renesas Electronics products, such as safety design for hardware and software, including but not limited to redundancy, fire 
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software 
alone is very difficult and impractical, you are responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. 
You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of controlled substances, including 
without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these applicable laws and regulations. Renesas Electronics 
disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under 
any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations promulgated and administered by 
the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or transfers the 
product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 
14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled subsidiaries. 
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.  
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Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 
Koto-ku, Tokyo 135-0061, Japan 
www.renesas.com 

 For further information on a product, technology, the most up-to-date 
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